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1 Preface 

The described hardware and software are developments of the KEB Automation KG. The 
enclosed documents correspond to conditions valid at printing. Misprint, mistakes, and 
technical changes reserved. 

1.1 Signal words and symbols 

Certain operations can cause hazards during the installation, operation or thereafter. Re-
fer to the safety information in the documentation about these operations. Security signs 
are located on the device or on the machine. A warning contains signal words which are 
explained in the following table: 

 DANGER  ➢ Dangerous situation, which will cause death or serious injury in case 
of non-observance of this safety instruction. 

  

 WARNING  ➢ Dangerous situation, which may cause death or serious injury in case 
of non-observance of this safety instruction. 

  

 CAUTION 
 
➢ Dangerous situation, which may cause minor injury in case of non-

observance of this safety instruction. 
  

ATTENTION  ➢ Situation, which can cause damage to property in case of non-ob-
servance. 

  

 

 

i 
 ➢ Is used when the result will be better, more economic, or trouble-free 

by following these procedures. 

1.2 More symbols 

► This arrow starts an action step. 

• / - Enumerations are marked with dots or indents. 

=> Cross reference to another chapter or another page. 

 

Note to further documentation. 

Document search on www.keb.de 

 

 

1.3 Laws and guidelines 

KEB Automation KG confirms with the CE mark and the EC declaration of conformity that 
our device complies with the essential safety requirements. 

http://www.keb.de/


Warranty 

4   © 2022  KEB Automation KG 
     

 

The CE mark is located on the name plate. The EC declaration of conformity can be 
downloaded on demand via our website. Further information is provided in chapter "Certi-
fication". 

1.4 Warranty 

The warranty on design, material or workmanship for the acquired device is given in the 
current terms and conditions. 

 

Here you will find our current terms and conditions. 

Terms and Conditions 

 

Further agreements or specifications require a written confirmation. 

1.5 Support 

Through multiple applications not every imaginable case has been taken into account. If 
you require further information or if problems occur which are not treated detailed in the 
documentation, you can request the necessary information via the local KEB Automation 
KG agency. 

The use of our units in the target products is beyond of our control and therefore 
exclusively the responsibility of the machine manufacturer, system integrator or 
customer. 

The information contained in the technical documentation, as well as any user-specific 
advice in spoken and written and through tests, is made to best of our knowledge and in-
formation about the application. However, they are considered for information only with-
out responsibility. This also applies to any violation of industrial property rights of a third-
party. 

Selection of our units in view of their suitability for the intended use must be done gener-
ally by the user.  

Tests can only be done by the machine manufacturer in combination with the appli-
cation. They must be repeated, even if only parts of hardware, software or the unit 
adjustment are modified.  

1.6 Copyright 

The customer may use the instructions for use as well as further documents or parts from 
it for internal purposes. Copyrights are with KEB Automation KG and remain valid in its 
entirety. 

Other wordmarks or/and logos are trademarks (™) or registered trademarks (®) of their 
respective owners and are listed in the footnote on the first occurrence. 

1.7 License agreement 

The conditions for using of KEB Software are listed in the GENERAL TERMS OF CON-
TRACT FOR THE CESSION OF SOFTWARE LICENSE PRODUCTS (EULA). 

 

https://www.keb.de/terms-and-conditions
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Here you will find our current EULA 

EULA  

 

 

1.8 Terms / Definitions 

Download  Transferring / writing data from COMBIVIS to the KEB device 
 
Upload Transferring / reading data from the KEB device to COMBIVIS 
 
Configuration-ID (cfg)  Any device type, firmware version, speed mode gets a unique identifier (number). 

Based on this, COMBIVIS can identify the device and select and display the correct 
parameter description. 

 
CV6 Abbreviation for COMBIVIS 6 
CVs6 Abbreviation for COMBIVIS studio 6 
 
 

https://www.keb.de/fileadmin/AGB/2018_04_25_KEB_EULA_EN.pdf
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2 Overview 

2.1 Properties 

• Based on CODESYS Automation Platform and  .NET-Framework 

• History for program errors and messages 

• Integrated start-up assistants (wizards) 

• Integrated KEB document database 

• Integrated device configurator 

• Integrated determination of the energy efficiency of KEB COMBIVERT 

• Integrated Safety Editor for safe communication to the KEB Safety Modules 

• 16-channel oscilloscope 

• Serial communication via protocol DIN 66019II (serial or USB) or TCP/IP UDP 

• IP-addressing for several devices 

• Automatically detection of USB-converters 

• Searching on several serial interfaces in parallel 

• HSP-5 service via KEB-USB-serial converter or KEB port expander 

• Update function via Internet  

• Can be used to COMBIVIS 5 in parallel, but no service of the same COM-Port 

• Support of COMBIVERT type F5/ B6/ G6/ F6/ H6/ P6/ S6/ T6, COMBICONTROL C6 and Step-
per/BLDC 

• Older devices like COMBIVERT 51 to 58 / F0 to F4 are not supported! 

• No visualization of operator parameter menu of F5 Devicenet- and early InterBus- and CAN Opera-
tors (separate operator menu in CV5) 

• Different versions can be installed in parallel 
 
Enhancements of version 6.7.0 compared to version 6.6.0 amongst others: 

• New versions can be installed in parallel to former version 

• Version manager 

• Project can be stored compatible to current or former version or other profile 

• Navigator order of devices and folders enhanced 

• Storing of parameter lists format “dw5” preferred to “cvxpl” 

• Backup preferably creates “dw5” format (previously “cvxpl”) 

• Scopes can be attached to the device 

• Display of STRING parameters 

• Package Manager displayed in CV 6 for deinstalling of packages 

• Import / Export of CV options 

• FTP communication accelerated, i.e., device storage wizard works faster. 

• Vendor name is printed out with Safety Editor configuration 

• Safety Editor uses English with language setting "not English or German” 

• Anonymised usage analysis 

• Fieldbus wizard with selection of process data size 

• No release for Microsoft Windows 7 or 8/8.1 

• Additional Profile COMBIVIS studio 6 safety 
 
Fixed Bugs of version 6.6.0 

• Errors when printing parameter lists and configurations 

• CAN EDS file, various errors  

• IEC Plaintexts in German generated error message  

• Safety Editor “Year 2038 Bug” 

• Recipe generation error with empty first line 

• Script error due to incorrect call of KEB homepage 

• False access type in Powerlink xdd export 

• S6 standard mapping, data type of “modes of operation” wrong 
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For more information => Release Info under menu “Help” → “Show release notes” 
 

2.2 Types 

The free of charge COMBIVIS installation file consists of 3 modules: 
 
The respective program version is opened by selecting the program profile. 
 

• Parameterization version “COMBIVIS 6” (issue of this manual) 
o For parameterizing and analysis of KEB COMBIVERT 
o Calculation of energy efficiency 
o KEB Product Configurator 
o Document data bench (registration needed) 
o Without run time limitation 

 

• Programming version “COMBIVIS studio 6” 
o Additionally: 

▪ SPS programming in IEC 61131-3 (C6 controllers) 
▪ Bus configuration (e. g. EtherCAT, CAN, Profinet ...) 
▪ Configuration of Remote I/So 
▪ Other additional components 

o Licensing requested with costs 
o Demo version for free, time-constrained (1h) and no boot projects  

 
The two modules can be started via the desktop icons or the start menu. 

 

 
 
Optional: 

• Programming version „COMBIVIS studio 6 Safety“ 

o Additionally, to COMBIVIS studio 6: 
▪ CODESYS Safety Extensions 
▪ Adaptions for safety  

 
This version is safety conform tested and fixed. 
So, some later fixed enhancements or bugfixes of COMBIVIS studio 6 might 
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 not be included. 
The offering of the profile can be selected at installation of COMBIVIS studio 6. 
Opening by icon on the desktop. 

 

Additionally, the other program files can be installed: 

• Visualization platform “COMBIVIS studio HMI” 
o Editor with complete SCADA functionality 
o Wide graphics library and toolbox with customized control elements 
o Easy data exchange with COMBIVIS studio 6 projects 
o Chargeable licensing required 
o Demo version for free, time-constrained 

 

• Remote maintenance with “COMBIVIS connect” 
o Monitoring, project update and maintenance via "end-to-end"-VPN 
o Allows direct global support of KEB devices 
o Control centre free of charge 
o Requires one-time licensing a company domain 

 
For further information, please contact KEB. 
 

2.3 System Requirements 

 

ATTENTION 
 ➢ COMBIVIS 6 and COMBIVIS studio 6 are designed to work on Win-

dows Desktop systems only. Other systems like Windows Embed-
ded, Windows IoT or Windows Server are not supported. 

 
Minimum equipment for smaller projects: 
 

• Windows 10, in 32-bit or 64-bit version 

• Microsoft .NET framework version 4.7.2 (will be installed if it is missing) 

• 2 GHz Processor 

• 2 GB RAM (4 GB recommended) 

• 2.5 GB hard disk storage free 

• Screen resolution min. 1024 x 768 

• Display size 100% or 125% (150% with limitations) 
 
For the Safety Module Editor in COMBIVIS (Configuration / parameterization of safety modules in COMBI-
VERT F6, S6, and H6) (=> 14 KEB Safety Module Editor) some other requirements are valid: 

• The safety module editor requires a Microsoft Windows 10 operating system. 

• The current service pack should be installed. 

• The language must be English or German. If not, English is used. 
 
The system requirements for the COMBIVIS studio 6 Safety Editor (Programming of KEB Safety PLC und 
Safety I/O modules) can be found in the current manual. It is accessible via menu bar: “Help” → “Show 
safety-manual”. 
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2.4 Version Information 

The version information is displayed at the start page 
 

 
 
 
 And, by menu: “Help” → “About….” 
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2.5 Online Tutorials 

On the KEB YOUTUBE channel information and tutorials are offered. 
 
Information, Applications, Technology: 
https://www.youtube.com/channel/UCf577xwEcis-zTqrSAUCVXw 
 

 
 
Tutorials: 
https://www.youtube.com/playlist?list=PLWebebk4oOl_UOXashjFA58aE1bHToOM- 
 

 
 

Version of COMBIVIS 6: 

e.g., 6.7.0 
Version of underlying CODESYS-Software: 

3.5.17.21 

https://www.youtube.com/channel/UCf577xwEcis-zTqrSAUCVXw
https://www.youtube.com/playlist?list=PLWebebk4oOl_UOXashjFA58aE1bHToOM-
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2.6 Interface Hardware 

2.6.1 Connection of COMBIVERT F5. 

 
 
Note1): After disconnecting the operator from the device, the baud rate of the device internal HSP5 interface 
must be reset to 38400 baud by restarting the F5 (or set manually by parameter Sy11 to 38.4 kBaud). The 
connection HSP5-operator works with 250kBaud, which is too much for the PC. 
 
Connection possible also by KEB Port Expander (=> 2.6.4 Port Expander) 
 
 

By using an interface operator 

(Part No. 00F5060-2000) con-

nection at D-SUB 9-pole X6C: 

KEB-USB-serial-converter 

Part No. 0058060-0040 

Or: 

RS-232 cable PC / operator Part 

No. 0058025-001D HSP5 diagnostic interface 

X6B in field bus-operators 

and interface-operators: 

KEB-USB-serial-converter 

Part No. 0058060-0040 

+ 

HSP5-adapter D-SUB 9-pole / RJ45 

Part No. 00F50C0-0020 

Connection also via IP-operator 

Part No. 00F5060-8000 or 

Profinet-operator Part No. 00F5060-L100 

Please see FAQ-documents for instructions. 

 

HSP-5 interface D-SUB 9-pole X4A: 

USB-serial-converter Part No. 0058060-0040 note1) 
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2.6.2 Connection of COMBIVERT B6. 

 
 

2.6.3 Connection of COMBIVERT G6. 

 
 

HSP5 diagnostic interface X6B 

 

Connection by: USB-serial converter  

Part No. 0058060-0040 

+  

HSP5-adapter D-SUB 9-pole / RJ45 

Part No. 00F50C0-0020 

 

Or KEB Port Expander, => 2.6.4 Port Ex-

pander 

Connection to D-SUB 9-pole X4A,  

Protocol DIN 66019II: 

 

KEB-USB-serial converter, Part No. 0058060-0040 

Or: 

RS-232 cable PC / operator 

Part No. 0058025-001D 
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2.6.4 Connection of COMBIVERT H6. 

 
 
Access to drive units also via control unit by UDP/IP 
 

2.6.5 Connection of COMBIVERT P6. 

 
 

2.6.6 Connection of COMBIVERT F6. 

COMBIVERT F6 housing size D – W: 

Connection drive units directly to se-

rial D-SUB 9-pole protocol DIN 

66019II: 

RS-232 cable PC / operator 

Part No. 0058025-001D 

or: 

KEB-USB-serial converter 

Part No. 0058060-0040 

Interface X6A: 

Connection of the drive controller directly to 

serial D-SUB 9-pole protocol DIN 66019II: 

KEB-USB-serial converter 

Part No. 0058060-0040 

or 

RS-232 cable PC / operator 

Part No. 0058025-001D 
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COMBIVERT F6 housing size 1 – 9: 
 

 
 

Connection directly to serial D-SUB 9-pole 

protocol DIN 66019II: 

KEB-USB-serial converter  

Part No. 0058060-0040 

or 

RS-232 cable PC / operator 

Part No. 0058025-001D 

Via pluggable operator: 

LAN interface: Part No. 00F6P00-2000 

USB-B interface: Part No. 00F6P00-3000 

Instead of operator: 

Interface X4A: 

Connection directly to serial D-SUB 9-pole 

protocol DIN 66019II: 

KEB-USB-serial converter  

Part No. 0058060-0040 

or 

RS-232 cable PC / operator 

Part No. 0058025-001D 

F6-Pro: Multi Ethernet interface: EtherCAT or 

Ethernet  
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Pluggable operator with LAN Interface Part No. 00F6P00-2000: 
 

 
 
Pluggable operator with USB Interface Part No. 00F6P00-3000: 
 

 
 
The F6 operator can be used also on COMBIVERT S6 and H6. A good-shielded D-sub 9-pole extension ca-
ble can be used to connect the operator with the serial DIN 66019 interface on the COMBIVERT S6/H6. 
 

LAN interface cable 

The IP address must be adjusted in parame-

ter Fb01 by keyboard => device manual. 

USB A-B cable 
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2.6.7 Connection of COMBIVERT S6. 

 
 

2.6.8 Connection of COMBIVERT T6. 

 
 
 

2.6.9 Connection of C6 Stepper/BLDC 

 
Connection via COMBICONTROL C6 with COMBIVIS studio 6 
Sample project available. See document data bench: FAQ C6 RIO 0001 QuickstartStepperBLDC 

Connection directly to serial D-SUB 9-pole 

protocol DIN 66019II: 

KEB-USB-serial converter  

Part No. 0058060-0040 

or 

RS-232 cable PC / operator 

Part No. 0058025-001D 

F6-Pro: Multi Ethernet interface: EtherCAT or 

Ethernet 

Connection via LAN interface by standard 

LAN cable 
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2.7 Accessories 

2.7.1 DIN 66019II - RS-232 cable, PC / Operator 

Part No. 0058025-001D 

 
 

 
 

2.7.2 KEB-USB-Serial Converter 

Part No. 0058060-0040 

Housing (PE) 

D-Sub 9-pole female D-Sub 9-pole male 

H6 / G6 / S6 / F6 / P6 / 

F5- Interface operator PC 
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Converts USB into serial DIN 66019 II and HSP5 D-SUB 9-pole 
 

 
 

• The USB-serial-converter represents a virtual COM interface 

• It is not a customary USB serial converter, because the serial protocol is not transferred completely 

• On USB‘s side always DIN66019II is running 

• A connection of several USB-serial-converters, each with a serial- or HSP5-unit, is possible 

• Both interfaces are potential separated 

• Don´t need an external voltage supply 

• The 9-pole serial side supports with auto detection: 

• DIN66019 based on of RS 232 

• HSP5 (TTL level) 

• 38.4 kBaud should be used as baud rate 

• Max. baud rate is 115,2 kBaud 

• No support for automatic adjusting of baud rates 

• Baud rate can be adjusted with COMBIVIS 6 

• Cannot be used for firmware flashing 
 
File Transport Program FTP / Drive Storage  
 
Transferring of receipts by 17.2 FTP Program or the wizard drive storage to COMBIVERT F6/S6 is possible 
from Version V2.4 
Matching USB converters are signed with “FTP ready”. 
 

 
 
Driver installation 
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While installation of COMBIVIS 6 the driver for the KEB USB Converter will be installed automatically. If it is 
not wanted it can be disabled at setup: 
 

 
 
The signed driver “kebcdc.inf” can be found in the COMBIVIS 6 installation folder “C:\Pro-
grams\KEB\COMBIVIS_6\Drivers”. 
 
The KEB-USB converter 0058060-0020 is no longer manufactured. It has basically the same properties, but 
no potential separation. Due to data transport problems this should not be used on COMBIVERT F6 / S6. 
 
Please note at COMBIVERT F5/B6 on HSP5 interface: 
 
Node addresses are not specified in HSP5 interface of the USB-serial converter. So COMBIVIS 6 will find a 
device on each scanned address! 
E.g., while scanning address 0 and 1 the same device will be found and included twice, regardless of which 
current node address is adjusted. 
So, search for connection by HSP5 only on one address! 
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In "Connect to device" remove the checkmark "Node address autodetection", otherwise the device will be 
integrated in the project up to 240 times! Typically, node address 1 is used. 
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2.7.3 HSP5-Adapter 

 D-SUB 9-pole / RJ45 
 Part No. 00F50C0-0020 
 
Useful for COMBIVERT B6 and F5 bus operators (HSP5) only with KEB-USB-serial converter! 
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2.7.4 Port Expander 

 Ethernet / USB – HSP5 converter 
 Part-No. 00F5025-0080 
 
The Port Expander has been discontinued and is only available for a limited time! 
 
The port expander is a communication gateway with Ethernet and USB interface and 4 HSP5/485 interfaces 
for connection to drive controllers or operators of KEB COMBIVERT. 
With the port expander up to 4 devices with HSP5 interface with COMBIVIS 6 can be addressed, because 
the port expander can convert the HSP5 protocol to DIN66019. 
 
Connection options in detail: 
 
Input side: 

• USB on USB-B-interface 

• Ethernet: 
o ARP  Address Resolution Protocol Response 
o ICMP  Echo Response (Ping) 
o TCP/IP  DIN66019II, Modbus/TCP, Http 
o TCP/UDP DIN66019II, Modbus/TCP 
o DHCP  BootP Response, switchable 

Output side: 

• At each of the 4 output interface a HSP5 device (F5 control board (X4A) direct / F5 bus operator / 
B6) 

• Port 4 (X4D) may alternatively be set to RS485 bus DIN66019II so theoretically up to 235 partici-
pants with a serial interface DIN 66019II. (F5-Interface Operator / G6 / H6 / P6 / F6 / S6) 

 
Power is supplied by an external 24V power supply or via the USB cable. 
The Port Expander can be run locally on the table or mounted on a DIN rail in the control cabinet. 
 
Numbers: 
 

Part number Name Characteristics 

00F5025-1080 PORT EXPANDER SET 
with USB A-B, Cable -4025 und HSP5 Adapter -
0020 

00F5025-0080 PORT EXPANDER  USB-, Ethernet-, 4x HSP5-interface, ext. 24V 

00F50C4-1010 USB- Cable USB A-B, 4-pol., l = 1 m 

00F50C0-4010 Cable RS 485/ HSP5 Connection RJ 45 – D-SUB 9, l = 1 m  

00F50C0-4020 Cable RS 485/ HSP5 Connection RJ 45 – D-SUB 9, l = 2 m  

00F50C0-4025 Cable RS 485/ HSP5 Connection RJ 45 – D-SUB 9, l = 2.5 m  

00F50C0-4050 Cable RS 485/ HSP5 Connection RJ 45 – D-SUB 9, l = 5 m  

00F50C0-0020 Field bus adapter HSP5 D-SUB 9 / Western 400 mm 

00F50C0-0021 
Cable RS 485/ DIN 
66019II 

Connection RJ 45 – D-SUB 9,  l = 2,5 m 

 
The inexpensive starter kit Part No. 00F5025-1080 belongs of: 
 

  Part number Name Characteristics 

1x 00F5025-0080 PORT EXPANDER  USB-, Ethernet-, 4x HSP5-Schnittst., ext. 24V 

1x 00F50C4-1010 USB- Cable USB A-B, 4-pol., l = 1 m 

1x 00F50C0-4025 Cable RS 485/ HSP5 Connection RJ 45 – D-SUB 9, l = 2.5 m  
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1x 00F50C0-0020 Fieldbus Adapter HSP 5 D-SUB 9 / Western 400 mm 

 

 
 
Wiring examples: 

 
 

Cable RS 485 / DIN 66019II Part 

No. 00F50C0-0021 

Cable HSP5 

Part No. 00F50C0-4025 

Field bus adapter HSP5 

Part No. 00F50C0-0020 

Communication Port Expander to serial 

DIN 66019II (only port 4) Type G6, F6, 

S6, H6 and P6 

Communication Port Expander to 

HSP5 (port 1-4)  Type F5 and B6 

Port Expander 

Part No. 00F5025-0080 
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The cable Part No. 00F50C0-4025 can also be plugged directly into the Sub-D9-pol HSP5 socket of the F5 
instead of the operator. 
 
Further information can be found in the manual. Please search for "00F5025-0080" or "Port Expander" on 
the KEB homepage www.keb.de. 
 
For searching of the devices, the node addresses 0 to 5 must be adjusted (node 0 = Port Expander, node 1-
4= the HSP5 ports X4A – X4D). 
 
Driver installation 
You will find the USB driver “FTDI_USB_Serial_Converter” in the COMBIVIS 6 installation folder “C:\Pro-
grams\KEB\COMBIVIS_6\Drivers” (please unpack before installation). 
 

2.8 Installation 

Since version 6.6.0 there is only one installation file. When installing, you can choose whether the standard 
version COMBIVIS 6 or the extended COMBIVIS studio 6 version should be installed. 
For a new installation or when updating COMBIVIS 6, the selection is pre-set to COMBIVIS 6. When updat-
ing COMBIVIS studio 6, COMBIVIS studio 6 is pre-selected. 
 

 
 
 
When COMBIVIS studio 6 is chosen, the COMBIVIS studio 6 safety profile can be selected additionally. 
COMBIVIS studio 6 safety includes the CODESYS safety extensions and some safety adaptions (=> 2.2 
Types). 
 
Sandbox Installation 
 
Since version 6.7.0, several COMBIVIS versions can be installed in parallel.  
 

http://www.keb.de/
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Use cases: 

• Allow parallel installations of safety-version and non-safety version 

• Allow keeping old version installed 

• Allow pre-testing of beta versions quickly, avoid influence on a productive environment 
 
 
In case of parallel installation, some files are shared: 

• Document database 

• Feature management 

• KEB version manager 
 
Some files are used individually: 
COMBIVIS 

• Parameter descriptions / wizard descriptions 

• Configurator database 

• Updates 
COMBIVIS studio 

• Complete development environment including compiler 

• Libraries (optional shared) 

• Device descriptions (optional shared) 
Misc. 

• Visu profiles 

• Options 

• Packages, plugins 
 
When starting the installation, you can choose whether the previous version should be deleted or remain. 
 

 
 

• Uninstall: the older version will be uninstalled; the new version will be installed and substitutes the 

old version. 

• Keep: The new version is installed and add. 
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After “keep” you find 2 (or more) start icons on the Windows desktop: 
 

 
 

2.9 Version Manager 

 
On the start page you will find the version manager: 
 

 
 
Or in Windows Start Menu: 
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This can be used to manage the individual versions. 
 
The "Installed" card shows the installed versions: 
 

 
 
Function fields:  

• “Launch”: launches profile in this version (CV6 or CV studio 6 or CV studio 6 Safety).  

• “Uninstall”: uninstall version 

• “Ignore Updates”: do not update version. Updates are carried out within the version (documents, 
parameter description, etc.). 

• “Update”: install newer version 
 
On the "Available" card, versions provided by KEB but not installed are offered for installation (internet con-
nection required): 
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2.10 Silent Installation 

The COMBIVIS 6 setup was created by “INNO Setup” installer. The setup file can be performed also in 'silent 
mode'. More information will be found here: http://www.jrsoftware.org/ishelp/index.php?topic=setupcmdline. 
 
COMBIVIS (studio) 6.6.0 Setup can be configured so that "Compact installation" is set from the start: 
For this you must add the parameter / TYPE = "compact" to the call, for example: 
"Setup_COMBIVIS_studio_6_V6.6.0_B227_R17_(TC1).exe" /TYPE="compact" 

 
Result: 

http://www.jrsoftware.org/ishelp/index.php?topic=setupcmdline
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Prevent the standard association of the file extension ".project" with CV: 
"Setup_COMBIVIS_studio_6_V6.6.0_B227_R17_(TC1).exe" /MERGETASKS="!associatePro-

jectFileExtension" 

 
This command can also be combined with the above "Types" parameter. 
 

2.11 KEB Analysis 

KEB COMBIVIS 6 uses AppCenter, an analysis service from Microsoft, from version 6.7.0. KEB thus re-
ceives information on how users use the programme.  
For example: Which version is used? Which parts of the programme are used how often? On which operat-
ing system is COMBIVIS running?  
No personal data is collected! 
The analysis can be switched off: 
Menu "Tools" → "Options" → "KEB Analysis": 
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A sample for analysis of used OS, PC type, language, using time: 
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3 Start-Up 

Handling of a KEB device in COMBIVIS 6 requires at every time generating a new project or starting an ex-
isting project. 
 
Communication set-up to the device can be done 

• Via setting a new project and project assistant (=> chapter 3.1) 

• Or directly by scanning of interfaces (=> chapter 3.2) 

• Or setting of communication values directly at known hardware (=> chapter 3.3) 
At last, both a temporary project is generated in the background. It can be saved later by menu “File” 
→“Save project as…” 
 
If only an existing parameter list may be loaded to the KEB COMBIVERT, the function “Download param-
eter list” on the start page can be used (=> chapter 3.6). 
 
In COMBIVIS basic settings you will find the start page after starting up COMBIVIS 
 

 
 
On the start page some direct-link buttons are offered. 
 

 
 
Recent projects: 

Via icon    the start-

ing page can be acti-

vated again at any time 

By pulling the mouse 

cursor on a button the 

description of the func-

tion is shown 
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3.1 Start-Up with project assistant 

3.1.1 Starting via Project Assistant 

The automated project wizard (assistant) opens a new project, operates a predefined searching for con-
nected devices and integrates the located devices into the project. 
After entering “New project” the window “project assistant” / “empty project” will be shown. 
Alternatively, one of the last used projects can be opened. 
 
 

 
 
By selection “Empty project” the searching / integration of devices must be done manually. 
The icon “Configuration” opens the KEB System Configuration 
The icon “KEB device scan” opens the device scan window (=> 3.1.2 Scan for devices) 
 

With “needle vertical” projects can be fixed in 

the position in the list. With “cross” the name 

can be deleted out of the list. 

By “New Project” a project is 

generated, and the project 

assistant starts 



Start-Up 

38   © 2022  KEB Automation KG 
     

 

 
The scanning runs automatically depending on pre-configuration. 
 

 
 
Please note: Drive controller connected by RS485 need to have different node addresses! 
 
The explanation of the functions of the window can be found in chap. 3.1.3 Searching for devices -manually 
 
If devices are found, please see => 4 Device editor 
 
If no device will be found, please change adjustments, => 3.1.3 Searching for devices - manually 
 

Input of project’s 

name and storage lo-

cation 

Start or interrupt - 

The adjustments can be 

changed and reconfig-

ured. 
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3.1.2 Start-Up with Empty Project 

 
 
With an empty project it is possible to start a specific scan with connected devices or without connected de-
vices they can be integrated manually. 
 

3.1.3 Searching for Devices – Manually 

Open an empty project – or from an existing project – click on: 
Menu bar “Project” → “KEB device scan” 
 

 
 
Or another way: Click on button “KEB device scan” in the tool bar. 
 

Start with an empty project 
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The scan run can be controlled in the window “KEB device scan”. 
Differing to the standard setting other COM-interfaces, addresses, baud rates or IP-addresses can be 
scanned temporarily. 
 

 
 
If searching via KEB USB serial converter at F5/B6 (HSP5 protocol) please read the notes in 2.6.2 
KEB USB-serial converter! 
 
With known communication data, a device can be set directly without searching => 3.2 Directly scan for de-
vices  
 

3.1.4 Start-Up Offline (Without Device) 

If COMBIVIS 6 shall be opened without a connected device, then it must be added manually. So, for exam-
ple a parameter list can be manually generated offline. 
 

Store current setting as 

default 

Stop searching 

Select devices, 

which are to add 

on (☑) 

Start searching 

Adding the located de-

vices to the active pro-

ject 

Scan area  

TCP/IP UDP 

Scan area of 

COM-interfaces 



Start-Up 

© 2022  KEB Automation KG   41 
     
 

• Open an empty project 

• Click left mouse key on button on tool bar: “Add a new KEB device to the project” 
 

 
 
Choose “Offline”: 
 

 
 
For help of adjustment of the correct device group an overview list for COMBIVERT F5 and G6 can be found 
under: Menu “Help” → “Show COMBIVIS 6 “FAQ”-Documents” → “COMBIVIS 6” → “CV6 FAQ0005 F5 G6 
Short names operating modes”. 
 
Fill in the name of the device which is to add.  
 

 
 
The device name must not begin with a character (0….9)! CV6 sets an underline in front of the character au-
tomatically. 
 
Offline device will be added and the window “device editor” opens. 
→ Continue in  4 Device editor 
 

3.2 Directly Scan for Devices on Interfaces 

By using the button “Scan for devices” a temporary project is generated and a window with scan properties 
opens. 
 

Choose device group and -type 

respectively device Config-ID 

 

If necessary, also choose an 

operator or control type (G6) 

 

Enter: 

“Add device” 
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The found devices will be opened in the navigator window. 
 

3.3 Directly Connect to Device (Add Device) 

By using the button “Connect to device” a temporary project is generated and a window with interfaces prop-
erties opens. 
In the case of an online connection, after setting the connection data, a scan is carried out and found KEB 
devices are displayed immediately. 
Because COMBIVIS knows all the parameters of all KEB devices from type F5, a device can also be created 
"virtually". 

By “Scan for devices” a 

temporary project is 

generated, and the scan 

assistant starts 

Store current setting as 

default 

Stop searching 

Select devices, 

which are to add 

on (☑) 

Start searching 

Adding the located de-

vices to the active pro-

ject 

Scan area of 

Ethernet interfaces 

Scan area of se-

rial interfaces 
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When connecting via UD / IP (Ethernet): 
The window shows an input field for the IP address. At the same time, a network scan is performed, and the 
devices found are listed. Default port and node address are detected automatically. 
The devices found via the IP address are listed below and can be added to the project. 
 

 
 
Note: With the KEB Port Expander Part No. 00F5025-0080, the automatic search will find the devices on 
each scanned port (8000 and 8001) and lists them twice. Please set a fixed port here. 
 
At communication via serial or USB: 

By “Connect to device” 

a temporary project is 

generated, and the scan 

assistant starts 

By IP address found devices: 

 

Enter: “Add device” – adds 

this device to project and 

window stays open 

 

“Add all devices and close” – 

Window closes 

Set communication data 

IP address 

Devices found in network 
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Offline (virtual device): 
With "Offline", the device can be selected manually based on the type / firmware version or with a known 
configuration identifier.

 
 
The found devices will be opened in the navigator window. 
 

3.4 Open an Existing Project 

On Start page: 
 

Enter: “Add device” – adds 

this device to project and 

window stays open. 

“Add all devices and close” 

– Window closes 

Set communication data 

Detected USB connections 

are suggested. Set baud rate 

manually 

"Communication Test" - 

runs through each setting 

change once. Found de-

vices are listed immedi-

ately. 

Choose device group and -type 

respectively device Config-ID 

 

If necessary, also choose an 

operator or control type (G6) 

 

Enter: 

“Add device” 
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Or: 

 
 
After opening an existing project without connected devices: When saving the project, the state of the de-
vices will remain. 
 

3.5 Navigator 

The navigator window shows all devices, lists, scopes, and other folders belonging to the project. 
 
The navigator normally appears on the left side of the window. If it is not visible there, it can be displayed 
with the menu bar "View" → "Navigator". 
 

 
 

By “Open Project” a 

project will be opened 

Open an existing project with “File” → 

“Open project”  

 

Or: 

 

Open an existing project with “File” → 

“Recent projects” 
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Predefined folders are attached to the project and the device (Parameter Cockpits => Chap.22, Parameter 
Lists => Chap.8, Scopes => Chap.9, Wizards => Chap.10). If not needed, these can be deleted. 
 
Add a folder, a list, or a scope by click on the project name or device name → right mouse button → "Add 
object". 
 

 
 
Objects attached to the project apply to several units, objects attached to the unit only apply to this unit. 
 

Project name 

Device in the project 
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Display of the communication status: 
 

 
 

 
 
Alternatively, the communication status can also be changed via the context menu: right mouse button → 
"Online" / "Offline". 
 

 

Device online, connection 

active 

Device disconnected/ 

offline, no observing of 

the communication 

 

Device online, but no con-

nection 
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Change device name: 
The name of the device in the project can be renamed. Therefor click with left mouse key on the name of the 
device in the navigator. Then the name can be changed. The device name must not begin with a character 
(0….9)! 
 

 
 

3.6 Direct download of a parameter list 

The function specifies a path with which a parameter list saved anywhere can be load into a KEB device 
(Download). 
By choice box “Download parameter list” on the start page a temporary project is created, the belonging pa-
rameter list is chosen; the communication to the COMBIVERT is set und after connecting the parameter list 
is loaded to the device. 
 

 
 
Mark the parameter list and “open”: 
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A temporary project is created and a device matching the parameter list is added. The communication set-
tings are asked for. 
 
When connecting via UD / IP (Ethernet): 
The window shows an input field for the IP address. At the same time, a network scan is performed, and the 
devices found are listed. Default port and node address are detected automatically. 
The devices found via the IP address are listed below and can be added to the project. 
 

 
 

By IP address found devices: 

 

Enter: “Add device” – adds 

this device to project and 

window stays open 

 

“Add all devices and close” – 

Window closes 

Set communication data 

IP address 

Devices found in network 
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Note: With the KEB Port Expander Part No. 00F5025-0080, the automatic search will find the devices on 
each scanned port (8000 and 8001) and lists them twice. Please set a fixed port here. 
 
At communication via serial or USB: 

 
 
Enable download by “Yes”: 
 

 
 
After download, the result of the operation is display in the Message Window on the bottom of the COMBIVIS 
window: 
 

 

Enter: “Add device” – adds 

this device to project and 

window stays open 

“Add all devices and close” 

– Window closes 

Set communication data 

Detected USB connections 

are suggested. Set baud rate 

manually 

"Communication Test" - 

runs through each setting 

change once. Found de-

vices are listed immedi-

ately. 
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The download is finished and the COMBIVIS can be closed. 
 

3.7 Storing the Project 

The project can be stored in the current version or in former version. And as well as can be stored in 
COMBIVIS studio 6 as COMBIVIS 6 or the other way round. 
 
by “File” → Save Project” with the same name and profile or by “Save Project as…” with a new name or in 
other profile. 
 

 
 
"File" → "Save project as ..." → File type 
 

 
 
If another profile of older version is needed, please contact KEB. 
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4 Device Editor 

• Online data communication, all parameter values will be modified online in the device. 

• Parameter storing must be affected by a separate parameter list (=>: 8.17 Parameter backup) 

• Each device has got its own device editor. 
 

4.1 Open Device Editor 

There are two ways to open the device editor: 
 

• Via double-click in the navigator on the name of the device(s) which is/are to edit, or: 

• Marking the name of the device(s) (1.) 
→ click on “down arrow” (2.) 
→ “open in editor” (3.) 

 
 

 
 

4.2 Device Reference 

The device reference number is the instrument to precisely distinguish all devices in the project. This number 
will be assigned in order of locating during device scan and describes the position of the drive controller in 
the data bus. It is independent from device node address. That means it can be changed after modification 
of the wiring and a new scan! Each device reference can only exist once. It cannot be changed manually. 
 

2. 

1. 
3. 
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A reference list with all devices can be displayed: 

• Context menu right mouse key in navigation window → “List KEB-Devices” 

• In menu bar; “project” → “List KEB-Devices” 
 

 
 

 
 

4.3 Switching Online / Offline of Active Device 

If an active device may be saved against unplanned adjustment or communication data may be changed the 
device can/ must be switched offline 
 

 
 
Alternative: 
 

Click on device by right mouse key 

“Online” with hook 
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4.4 Screen Layout 

 
 

4.5 KEB-Device 

Communication properties 
 

Choose device 

Switch online or offline 

Navigator: presentation and activation of the pro-

ject’s particular objects and devices 

Editor: Editing objects and devices, brake 

down in tabs according to:  

a) device and b) range 

Messages: 

Status, alarm- and error 

information will be indi-

cated and journalized 



Device Editor 

© 2022  KEB Automation KG   55 
     
 

 
 

 
 

4.6 Online Wizards 

Depending on the device type some Online Wizards are displayed. 
Online wizards are a start-up and adjustment help. Parameters and adjustments are done direct in the de-
vice (=>  10.1 Online Start-up Wizard). 
 

Operator’s currently firmware ID 

Status of the device 

(online / offline) 

Selection of devices or object’s function tables 

KEB-device: 

Device name and notes 

Communication data 

Firmware ID stored in the project 

Operator ID stored in the project 

Firmware ID currently in device 

Device reference is set automatically 

at scanning 

Expert settings 

Addressing mode of parame-

ters global or explicit = individ-

ual for each device 



Device Editor 

56   © 2022  KEB Automation KG 
     

 

 
 

4.7 Device Parameters 

In the tab Device-parameters the function parameters of the device (Drive controller) are displayed in the 
current state. Modifiable parameters can be changed directly in the device here. Parameters of the pluggable 
operators at COMBIVERT F5 or control cards of COMBIVERT B6 and G6 are displayed in tab operator-pa-
rameters. 
 

 
 
One distinguishes parameter groups: 
 

Parameter groups: 

Open via click on “+” / “-” or 

tab key “Enter” / “Space” 

Open set-programmable or 

ARRAY or STRUCT or STRING 

parameters 

Edit parameter values: 

Left mouse - double click, or 

marking parameter and press 

key: “Enter” or: 

Double click → modify value in 

property editor 
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Set programmable parameter or ARRAYs: By opening with the “+” the individual set programmable parame-
ters or the subindices of the ARRAYs are displayed: 
 

 
 
Or variables: All variables are global and have in all parameter sets the same value. (Blue cube: writeable 
and readable, grey cube: only readable) 
 

 
 
Display options can be changed by context menu: 
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4.7.1 Set Addressing 

Is valid for COMBIVERT Type F5/ G6/ B6. In the basic setting of COMBIVIS 6 selection of parameter sets is 
direct.  
 
Global adjustments for all devices in “Tools” → “Options” → “KEB Parameterization” → Tab: “Parameters” 
 

Show in KEB Documents explanation for 

the parameter, => 11.4 Help 

Create a new parameter list with selected Pa-

rameters. Multiple selections by “Shift” and 

“Ctrl” –key. At first open all parameter groups 

from which parameters may be selected. 

All in monitor indicated parameters 

will be updated 

Only selected parameters will be indi-

cated and updated 

Open parameter groups, possible with 

keys r, o, p, c… (F8), close with 

“space”-key 

“Right mouse key” 
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Or explicit adjustment only for the current device: in “device editor” → “Communication settings” → “Expert 
settings” → “Addressing mode” 
 

 
 
In the editor, the current addressing mode is permanently displayed at the bottom. 
 

Expert settings 

Addressing mode of pa-

rameters global or explicit 

= individual for each de-

vice 
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4.7.2 Direct Addressing 

For each parameter is displayed, at what rate he is. 
In the first bottom view the address related parameter is shown. 
(In this picture: set 0 and 2). 
 

 
 
In the second bottom view (second “+“) all 8 parameters are shown in direct addressing mode. 
 

 
 

4.7.3 Indirect Addressing 

It works by set pointer Fr09. In the first bottom view shown values belong to the set to which the set pointer 
Fr09 is placed. Not-set-programmable parameters have in all sets the same value. 
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Only at the set pointer is shown to which set the actual shown values are belonging. The pointer is displayed 
permanently at the bottom of the editor window. 
The adjustment of the set pointer Fr09 can be done at the parameter in the editor or direct under the icon 

 in the tool bar. 
 

 
 
In the second bottom view (second “+”) all 8 parameters are shown in direct addressing mode. 
 

4.7.4 Active Set 

In the first bottom view the parameters of the actual used set are shown (=> parameter ru26, active set). 
In the second bottom view (second “+”) all 8 parameters are shown in direct addressing mode. 
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4.7.5 Addressing according CiA 301. 

4.7.5.1 Addressing of the COMBIVERT F6, H6, P6, S6, T6 

Addressing is done according to CiA 301. 
 
VARiables are marked with a blue or grey cube. (Blue: readable + writeable / grey: readable only). The pa-
rameter value is shown in the line. 

 
 

STRUCTure parameters are marked with a "tree symbol" . The associated sub-indices are again 
marked with blue/grey cubes (Blue: readable + writeable / Grey: readable only). 
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ARRAY parameters are marked with a "tree symbol" . The corresponding sub-indices are again 
marked with blue/grey cubes (Blue: readable + writeable / Grey: readable only). 
 

 
 
STRING parameters include text. Available only in COMBIVERT F6-Pro and S6-Pro (e.g., fb110). 
 

 
 

4.7.5.2 Addressing of the COMBIVERT G6 

The addressing of CiA 301 is like the direct addressing sentence of COMBIVERT F5. The subindices are 
numbered from 1 to x. The set 0 here corresponds to the subindex 1. Set 1 to subindex 2, etc. 
In the first bottom view (parameter sets closed) the number of available subindices is shown if the parameter 
is set programmable. At not-set-programmable parameters the value is displayed. 
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The display of closed parameters in the first bottom view can be changed. 
By in “Tools” → “Options” → “KEB-Parameterization” → Tab: “Parameter” → “ARRAYs” can be chosen if the 
number of subindices or the value of the first subindex will be shown. 
 

 
 
Or use context menu: right mouse key: “Display Subindex [1] for ARRAYs” 
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4.8 Operator Parameters 

The tab is shown only if an operator is detected. At COMBIVERT G6 the communication board is named as 
operator. 
Same behaviour as in tab “device parameters”. 
 

 
 

4.9  Documents 

In the tab documents all available documents (manual, data sheets…) are displayed. Only the associated 
documents are displayed by entering the device part numbers. Part numbers you enter here will be perma-
nently assigned to the device but can be changed by overwriting. 
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=> 13 Document Database 
 

4.10 Display Changing Between Editors 

Display of editors can be changed by: 

• Click on editor tab 

• Double-click on the object in the navigator 
 

 
 

• Key combination “CTRL+Tab” 
 
While fixing the “CTRL” key and one of the “←”, “↑”, “→”, “↓” keys can be selected which editor shall be 
opened. It displays only active editors. 
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4.11 Drive Storage 

The KEB COMBIVERT F6 / S6 can manage the recipe management. Certain parameter lists can be stored 
in the device memory and can later be loaded into the runtime environment in different ways. 
For storing the device storage wizard (=>17.1 device storage wizard) or the KEB FTP program (=>17.2. KEB 
FTP) can be used. 
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5 Property Editor 

For changing the parameter value, the property editor can be opened by double click with mouse on the 
value or mark by mouse and press “enter”-key 
 

 
 

5.1 Basic Setting 

In area “Property editor” can be adjusted if input window should be displayed sequential or permanently. 
Please click on: “Tools” → “Options” → “KEB Parameterization” → “Behaviour“. 
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5.2 Feature Selection 

 
 

Selection list 

“OK” takes the current value 

Input value. This value will be taken by 

“OK”. (Can also be given directly as a 

number) 

Scroll bar, slid able by mouse 

Selection list viewable / hidden 

Selection list and scroll bar can be used in parallel 
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5.3 Numerical Value Input 

 
 

5.4 Parameter Properties / Information 

The COMBIVIS device description file contains a lot of information "around" the parameters. These are 
shown when you click on the bar with the small triangle at the bottom of the Property-Editor window. 
 

 
 

5.4.1 Plaintext Export in IEC 61131-3 

 
With version COMBIVIS studio 6 the parameter plaintexts can be exported in IEC 61131 format. 
 
Context menu at the parameter: “generate IEC 61131-3 code” → “Create plaintext-function…” 

“OK” takes the current value 

Direct input and scroll bar can be used in 

parallel. 

Scroll bar, moveable by mouse 

Direct input of a number or value. 

This value will be taken with “OK” 

Via click on this arrow a window will be opened which 

displays basic data of the parameter: 

Hex. -address 

Limits 

Default value 

Resolution 

Data length 

… 



Property Editor 

© 2022  KEB Automation KG   71 
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6 General Adjustments 

General and special options can be indicated and adjusted in “Tools” → “Options…”. 
 

 
 
These adjustments will be saved automatically non-volatile. 
In the event of a version update, the option settings are retained. 
The settings can be exported and imported on another computer: 
Menu bar "Tools" → "Import and Export Options...". 
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6.1 Options - Language Settings 

There are 3 language areas: 

• Program language 

• Parameter language 

• Help 
These can be handled independent. If a language is not available English is shown. 
 

 
 
The parameter language can be adjusted by: “Options” → “KEB Parameterization” → “6.5 Parameter”. 
 

6.2 Configurator 

KEB Configurator settings can be adjusted for each start of the configurator. 
=> 18 Configurator 
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6.3 Options - KEB Documents 

=> 13.2 Use KEB Documents 
 

6.4 Options - Online-Update 

KEB COMBIVIS 6 can search for available updates and install if an internet connection is available. It is not 
only sought after program update, but also for updates to instructions, parameter files (required at firmware 
update in KEB- devices) and libraries. 
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Automatically check for updates weekly / monthly means next test 7/30 days after the last test if an Internet 
connection exists or at the next connecting after this date. 
 
COMBIVIS 6 uses the system settings for proxy settings. The settings can be changed explicit. 
 

 
 

Activates auto-

matically updates 

Choose at which date 

the update will be 

done 
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6.5 Parameterization - Parameter View 

 
 

6.6 Parameterization - Communication 

 
 

6.7 Parameterization - Parameter Lists 

Default settings of new opened parameter lists 
 

Display of normally invisible 

service parameters 

Display of service parameters 

with special password pro-

tection 

Parameter language 

If language file is not available, English will be used 

Addressing mode of parame-

ters => 4.7.1 Set Addressing 

Adjustments according to CiA 

301 

Instead of number of subin-

dices the first value of subin-

dex 1 is shown 

Active attribution of inter-

face and respective 

transfer rate. The number 

of COM interfaces de-

pends on the PC hard-

ware. 

Maximum waiting time 

for reply 

Control of circuit sta-

tus after each x sec-

onds 
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6.8 Parameterization - Behaviour 

 
 

6.9 Parameterization - Data Paths for Parameter Description 

Data path for the parameter description file (XML-file). Depending on drive mode and firmware for each KEB 
device one or more parameter description files are necessary. If the file is not available in COMBIVIS no pa-
rameters are displayed in the editor. By online update function the database can be actualized automatically. 
 
On the mains path the XML-Files of all addressable devices are stored. 

Behavior of the 

property editor (in-

put window) 

Behavior at error 

messages 

Available assistants 

will be directly at-

tached to the located 

device 
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Normally the parameter description (XML-file) may be stored in the default file. A second path / folder for 
e.g., additional/special parameter descriptions can be defined. 
 
This folder can be placed elsewhere but the data path must be achieved here. 
 

 
 

6.10 Options – KEB Scope 

=> 9.3 Scope Basic Settings 
 

6.11 Options - Load and Save 

Settings for loading, saving and for the start-window 
 

 

Actualize file 

Start window 

display 

Create backup file 

when storing the 

project 

Automatically create 

backup in the back-

ground 
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The backup is stored as “xxx.backup” and can be made readable again by changing in “xxx.project”. 
 

6.12 Miscellaneous 

In default all tabs in the device editor are directed horizontally. Alternatively, the tabs can be directed verti-
cally. 
 

 
 

 
 

6.13 Export or Import Options 

Certain options can be exported or imported. 

Set tabs in device editor 

horizontally instead of 

vertically (default) 
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7 Window Layout 

Reset window layout: 
 
All changes in the window layout can be reset by: Menu bar: “Window” → “Reset Window Layout” 
 

 
 
Change window layout manually: 
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The data tabs (editor-window, scope, parameter list…) can be displayed one below the other or side by side: 
Activate the data tab group which is to relocate – choose task menu “Window” → “New Horizontal or New 
Vertical Tab Group”. 
 

 
 
Alternative:  
Click on data tab which is to relocate, hold the key and put it to the middle of the screen. A cross for the ori-
entation will appear. If the data tab will be arranged above, below, on the right or on the left side depends on 
the selection (blue deposited area). 
 

 
 
The window can be shifted superimposed to the actual COMBIVIS window. At multiple screens using the 
window can be pushed to the other screen. The pushed window may be placed anywhere at the screen by 
mouth pointer. To reset it may be placed on the centre of the orientation cross. 
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Data tabs which are arranged one below the other or side by side can be rearranged by drag and drop to be 
placed as flags. 
 

 
 
Same behaviour when the flag is pulled to the centre of the orientation cross (see before).  
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8 Parameter Lists 

8.1 Properties 

• Parameter lists can be attached to projects or devices 

• Parameters of different devices can be stored in one list and can be uploaded or downloaded in par-
allel 

• Online and offline data will be indicated in the list at the same time 

• Direct or indirect set addressing or addressing according to CiA 301 of the parameters 

• “Drag and drop function” for parameters out of the device editor 

• Direct shifting/copying of parameters between editor and parameter list 

• Parameter lists will be saved with the project 

• Export / import of “.dw5” and “.wr5” lists 

• Printer functions 

• Parameter can get user-defined names 

• Parameter lists can be exported individually in CV6 or CV5 format 

• Parameter lists can be compared with actual device adjustments or with other parameter lists 

• Online and offline values can be compared directly 

• Export as recipe directly to the COMBIVERT 

• Export as EtherCAT CoE startup command file 

• The last upload or download is listed 
 

If only an existing parameter list may be loaded to the KEB COMBIVERT, the function “Download param-
eter list” on the start page can be used (=> 3.6 Direct Download of a Parameter List). 
 

8.2 Open a Blank List 

Attach a parameter list to a device or project: Mark device or project → in tool bar click on icon    → give 
new list a name → “Add” 
 

 
 
Or: 
Mark device in the navigator with right mouse key → “Add parameter list”. 
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Choose a name for the list and “Add”. 
 

 
 
Alternative: 
Right-mouse-key → choose “Add Object” → “KEB Parameter list…” → give list a name → “Open”, or:  

In tool bar click on icon    → “KEB Parameter list…” → give new list a name → “Add” 
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8.3 Open List with Marked Parameters 

When some parameters are marked, a new parameter list can be opened by context menu: “right mouse 
key” → “Create parameter list from selection”. 
With key “shift” and “Ctrl” several parameters in different groups can be marked at the same time. But all 
used groups must be opened before marking the parameters. 
 

 
 

8.4 Open Existing List 

Valid file formats: 
cvxpl = CV6-format 
dw5 = CV5 and CV6-parameter list 
wr5 = CV5-work list 
 
Parameter lists can be opened at an empty project. The matching device will be added automatically in of-
fline mode. 
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Attach a parameter list to a device or project: mark device or project → in tool bar click on icon    → 
hook at “Import parameter list from file” → file extension: “.cvxpl”= CV6-format / “.dw5” + “.wr5” = CV5-format 
→ “Open” → “Add” 
 

 
 
Or: 
Click with right mouse key on device → “Add new parameter list” 
 

 
 
Set the hook in “Import parameter list from file” → find the file → choose the file → “open”. 
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Alternative: 
Attach a parameter list to a device or project: Respective device/project  
Right-mouse-key → choose “Add Object” → “KEB Parameter list…” → hook at “Import parameter list from 
file” → file extension: “.cvxpl”= CV6-format / “.dw5” + “.wr5” = CV5-format → “Add”, or:  

In tool bar click on icon    → “KEB Parameter list…”→ hook at “Import parameter list from file” → file ex-
tension: “.cvxpl”= CV6-format / “.dw5” + “.wr5” = CV5-format → “Add” 
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Next step: 
 
The parameter list is appended to the device at which the dialog was opened. But it can also be chosen 
whether it is hung on another device in the project or on a virtual device, which has the same type as the one 
with which the list was created earlier. 
 

 
 
If there are parameters of several devices in the list (only at .cvxpl lists), it can be chosen which device of the 
list will match which device in the project. 
 
The new added parameter list will be opened directly in the editor  
 

Type and Firmware version of origin device / parameter 

list  

Choose one device of the project. The Firmware 

ID (Config-ID) is compared between list and de-

vice: orange=different  

Add new device: a new device with matching type 

and will be add to the project (Offline) 

 

Assign to existing device: parameter list will be 

added to a device of the project. No check of 

compatibility! 



Parameter Lists 

© 2022  KEB Automation KG   89 
     
 

 
 
Open parameter list without open project: 
 
A stored parameter list can be opened directly from Windows Explorer by double click or with button “Open 
parameter list” on COMBIVIS Start Page. A temporary project will be created in background. 
 

 
 

8.5 Create Complete List 

Open choice box by click with right mouse key on the respective device → Choose “Create complete list” → 
A parameter list with all device parameters will be created. 
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8.6 Layout of Parameter List 

 
 

Please note: 

This complete list is filled in column “offline” with 

COMBIVIS-default values and does not include yet 

the actual values of the device. For data storage it 

is essential to take an upload from the device be-

fore saving! 

Time stamp of modification, Upload 

or Download 

Area for notes 

Basis Config-ID of devices in 

this parameter list 
Origin Config-ID of the 

parameters 

Fading out description 
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*= not shown in default adjustment, => 6.7 Parameterization – Parameter Lists  
 
In the subindex and set column is only one value shown, depending on the valid addressing mode for this 
parameter. 
 
Display of columns in the parameter list: 
The columns which may be shown can be chosen by pulling up and close with mouse or: “right mouse key” 
→ “columns” → “set hook” 
 

 
 

Name of device* 

Subindex-

number 

Reference of device 

Line number 

Notes area 

User-defined name of 

parameter, changea-

ble* 

Parameter ID 

Set number 

Set value 

Actual value in 

device 

Write / read permission 
Online-indicator 

Parameter name 
Parameter address 

(hex) 
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Display grid lines: 
The grid lines can be activated by: “right mouse key” → “Advanced” → “Display grid lines” 
 

 
 

8.7 Self-Created Parameter List 

Open blank list (=> 8.2 Open Blank List) → mark and copy the parameter in the device editor → insert into 
the parameter list. 
 

 
 
“Copy” command: the selected parameters are copied. 
“Copy (extended)” command: the selected parameters plus the underlying subindices or set programmable 
parameters are copied. 

Open with right 

mouse click 
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Alternatively: 
Open list → place device editor and parameter list window beside each other (=> 7 Window layout) → mark 
the parameter in the device editor with left mouse key → hold the key → pull the parameter into the parame-
ter list (Drag&Drop). 
 

 
 
The parameter value is kept by copying the parameter. 
 

8.8 Insert an Empty Line 

To insert an empty line “right mouse key” → “Insert empty line” 
 

 
 
Empty lines have no influence. They are used only for structuring. 
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8.9 Insert a Transfer Pause 

 
 
Transfer pause without confirmation: 
Offline value: -2000 ms: 2sec pause, the remark text will be shown, after that the download goes on automat-
ically. 
 

 
 
Transfer pause with confirmation:  
Set offline value: (+) xx ms: unlimited pause and display of remark text. Download goes on after click on 
“OK”. 
 

 
 

8.10 Changing of Device Reference 

The device reference of a parameter can be affected by double-click on the device reference number. 
 
The change of one or more device references can be affected by marking of the corresponding lines in the 
column “DRef” → “right mouse key” → “Edit Device-Reference” → choose new device reference → “OK”. 
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8.11 Upload from Drive Controller into Parameter List 

Definition: with "Upload" is meant the reading of data from the KEB device into COMBIVIS. 
 

 WARNING  Open the control release or the STO inputs before upload, because 
at upload some pointer can be changed. Especially when values are 
written by bus system at the same time an unexpected moving of 
the drive can occur. 

  

 
Carrying out the upload into an opened parameter list: 

• Click on icon    in the tool bar, or: 

• Click right mouse key in the parameter window, choose “Upload list”, or: 

• Tap key “F5” and answer the following questions with “Yes”. 
 
The column “Offline value” will become overwritten with the values (online values) which are adjusted in the 
device. 
 

 
 
Be sure that the device reference in the list matches the target device´s reference! 
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Otherwise adapt the reference of the list (=> 8.10 Changing of Device Reference). 
 

8.12 Parameter Download 

Definition: with "Download" is meant the transfer of data from COMBIVIS to the KEB device. 
 

 WARNING  Open the terminal control release or the STO inputs before down-
load of parameter list into the device because some parameters can 
be written only at open control release terminal. And an unexpected 
moving of the drive can occur. 

  

 
If only one existing parameter list is to be loaded into a KEB COMBIVERT, the function "Download of a pa-
rameter list" can be used on the start page (=> 3.6 Direct Download of a parameter list). 
 
Carrying out the download of an opened parameter list: 

• Click on icon    in the tool bar, or: 

• Click right mouse key in the parameter window, choose “Download List”, or: 

• Tap key “F4” and answer the following questions with “Yes”. 
 
The values, which are adjusted in the device, will become overwritten with the values of the column “Offline 
Values”. Only the writeable parameters which are in the list will get overwritten. All the rest will remain unaf-
fected. 
 

 
 
Be sure that the device reference in the list matches the target device´s reference! 
Otherwise adapt the reference of the list (=> 8.10 Changing of Device Reference). 
 
Parameter-Download from a parameter list to several devices: 
 
Parallel up-/download from/to several devices (here: DRef 0 and 1) from a list is possible.  
Each parameter is dedicated to one device. Therefor the suitable target-CFG-IDs must be registered. Miss-
ing CFG-IDs will be added at up/download optionally. 
 



Parameter Lists 

© 2022  KEB Automation KG   97 
     
 

 
 
Parameters can be excluded from downloading if they are set in the R/W column to "Read only". 
 

 
 

8.13 Renaming Parameter List 

Double-click slowly in the navigator on parameter list’s name and rename. 
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8.14 Comparing Parameter Lists Directly 

On- and offline values can be compered in a parameter list directly by context menu: Right mouse key → 
“Advanced” → “Enable quick-compare” 
 
In column “Online value”:  
Green:  On-/ offline values equal 
Red:  On-/ offline values unequal 
Yellow: Parameter not existing 
 

 
 
Please note:  
If the parameter list is designed with indirect set pointer, all parameters in all sets will be compared only with 
1 set (the set to which the set pointer Fr09 is adjusted). For an expedient comparing use direct set or CiA 
301 addressing for the parameter list. (=> 8.17 Parameter backup) 
Some parameter values depend on pointer positions (e.g., Ud16, Ud22, In24 …). Online (in the device) these 
parameters are shown only once. In a complete data saving list these parameters are shown each by each 
with the related pointer. So, the different list parameters are compared every time with the same device pa-
rameter!  
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Example: Ud15 (CP-selector) is the pointer for Ud16 (CP-Address). In Ud15 one of 36 possible parameters 
and in Ud16 the related (application-) parameter address can be chosen. In a data saving list all 36 Ud15 
and Ud16 must be listed, but online, in the device, Ud15 shows every time the same value. That gives at 
comparing once an equal and 35 times an unequal value. 
 

 
 

8.15 Comparing Parameter Lists 

A parameter list can be compared with an actual device adjustment or with the offline values of another pa-
rameter list. 
 
Also, two different comparing modes are available: 

• Line by line comparing mode 

• Advanced mode, especially for offline-offline comparison, which can detect blocks of belonging pa-
rameters. By this missing or too much parameter can be identified and marked. 

 
Find by context menu - right mouse key → “Compare list” 
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8.15.1 Online Comparison 

Comparing of a parameter list’s offline values with actual online values in a device generates a new parame-
ter list with the different values of the device. The values of the parameter list are shown also in the offline 
column in the new difference list. 
 

 
 
It is possible to compare one list with parameters of several devices in parallel. 
 

8.15.2 Offline Comparison 

Comparing of a parameter list’s offline values with another offline parameter list creates a new list with the 
unequal values of the 2nd list. 
 

 
Comparison method 

Mode of com-

parison 

Settings of 

comparison 

Settings of 

comparison 

Comparing mode 
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There are two different comparison methods: 
 
Line-by-line comparison mode: 
Only the values in the same lines will be compared, independent which parameter is in this line! Displace-
ments in the list, e.g., by additional parameters will cause in a wrong result! 
This method works if both lists come from equal device e.g., backup before and after a changing 
 
Advanced “Diff” algorithm: 
This mode identifies groups of parameters which are in the same line on both lists. By this, missing parame-
ters or too much parameter can be identified. 
Please check the result. It is not guaranteed that all differences are found! 
If the list is most in different direction a satisfying result is impossible. 
 
Example: 
Two parameter lists with parameters which are not included at the other list. Also, at different adjustments at 
parameters which are in both lists. 
 

 
 

 
 
Result: 
Yellow: parameters with different adjustments. 
Green/grey: Parameters missing in one of both lists. 
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8.16 Convert Addressing of Parameter Lists 

With this command the addressing mode of a parameter list can be changed. E.g., a set addressed list into a 
list with subindex addressing/CIA 301 and vice versa. Also, an indirect addressed list can be changed to di-
rect addressing. 
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8.17 Parameter Backup 

A parameter backup is useful after the completion of the machine function or before a planned change of the 
setting. If necessary, the functionality of the axis has then been saved for a later device replacement. 
 
The parameter backup generates a parameter list in the project. This can be exported. 
In the wizard for the F6 / H6 / S6 / T6 / P6 there is also the backup function. This generates a backup file, 
which can be converted to a parameter list in the project (=> 10.1.1.1. Basic Settings). 
 
For all KEB COMBIVERT: 
Open → “Tools” → “Parameter Saving”  
 

 
 
All parameters of all devices can be saved in one list! 
 

New additional list with result 

Addressing mode after conversion  

Current addressing mode of list 

Mark if ARRAY parameters are in the 

list 

Overwrite the current list 



Parameter Lists 

104   © 2022  KEB Automation KG 
     

 

 
 
"Create a single merged list": All parameters of the selected units are saved in one list. This is positioned 
in the Navigator at the project. The distinction is made by the unit reference. 
 
"Create separate lists": A separate list is created for each selected device. This is positioned in the naviga-
tor at the respective device. 
 

 
 
"Create DW5 files instead of parameter list objects in the project": The separate lists are saved outside 
COMBIVIS as parameter lists in “.dw5” format. 
 
“Start”→ Upload starts. 
An interruption is possible with “Abort”. 
After upload is finished a window for adjustment of storage location will open. 
This list can be integrated in the project, or it can be stored externally. 
 
After the start a message can be shown: 
 

Choose devices you want to save from 

Choose if device- and/or operator parameters are to save 

Choose how to address 

the parameters. For ex-

planation see below => 

Chapter 8.17.1 Sort 

mode 

 

Indirect set addressing 

possible only at F5, B6 

und parts of G6 
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Explanation: If "WA" parameters are included in the list, the upload should not be started if data is being writ-
ten to the COMBIVERT at the same time by a bus system or other parallel communication. During the up-
load, pointers to memory cells must be adjusted. If information is written via this pointer at the same time, it 
may end up in a wrong cell. This could be, for example, a wrong target position. After the backup is finished, 
all pointers are back in their original position. 
 
The lists can be exported from the navigator. => Chap. 8.20 Export parameter list. 
 

8.17.1 Sort Mode 

Depending on the type of the COMBIVERT not all addressing modes are available. 
 
Parameter list design with indirect set addressing: 
 
Design of the list: 

• Set pointer Fr09 = 0 

• All set programmable parameters of set 0 and all not set programmable parameters 

• Set pointer Fr09 = 1 

• All set programmable parameters of set 1 
….. 

• Set pointer Fr09 = 7 

• All set programmable parameters of set 7 

• Operator parameters 
 
If the drive controller works in contouring mode (synchronous bus mode) the indirect set addressing 
must be used! 
 
Parameter list design with direct set addressing, joined parameters: 
Without set pointer, each parameter belongs direct to one set or several sets 
 
Design of the list: 

• Parameter X of set 0 

• Parameter X of set 1 

• Parameter X of set 2 

• Parameter X of set 3 
…… 

• Parameter X of set 7 

• Parameter Y of set 0 

• Parameter Y of set 1 

• Parameter Y of set 2 

• Parameter Y of set 3 
…… 

• Parameter Y of set 7 
……. 

• Operator parameters 
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All not set programmable parameters are written in set 0 
 
At subindex / CiA 301 addressing “joined parameters” is used always! 
 
Parameter list design with direct set addressing, joined sets: 
 
Without set pointer, each parameter belongs direct to one set or several sets. 
 
Design of the list: 

• All set programmable parameters of set 0 and all not set programmable parameters 

• All set programmable parameters of set 1 
….. 

• All set programmable parameters of set 7 

• Operator parameters 
 

8.18 CP Parameter 

CP-parameters are parameters displayed in the device display at COMBIVERT F5, B6, and G6 in a separate 
menu. The CP-parameters show selectable application parameters. 
In COMBIVIS 6 there is no actual CP parameter menu. This means that no operation is possible like on the 
display of the device. 
A list can be created which shows the assignment of CP parameter and application parameter. 
 
→ Click with right mouse key on the device in the navigator → “Create CP parameter list”. 
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In the column “#” the number of the CP parameter is shown. The parameter is the assigned application pa-
rameter. 
For example, in the picture above: CP03 shows “ru00 inverter state” 
 
Please note: 

• The assignment of the CP parameter is read out while creating the list. A subsequent change in the 
device is not reflected in the list! 

• A scaling or set assignment is not considered! 
 

8.19 Save / Export Parameter List  

A parameter list can be exported from the project into following formats: 
 

• “dw5”= COMBIVIS format - only 1 device in the list 

• “cvxpl”= COMBIVIS format – several devices in the list 

• “wr5”= COMBIVIS format – work list 

• EtherCAT CoE startup command file 
 

i  ➢ A “wr5” list does not store any values, just a list of (online) parameters! 

 

 

i  ➢ Parameter lists to be used on COMBICONTROL C6, F5-LCD operator or F6 
operator must be stored in "dw5" format. 

 

 
Export: 
Select parameter list in Navigator → right-mouse-click → “Export” → select storage format → select storage 
location. 
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Alternatively, from open parameter list: right-mouse-click → “Export” → select format: 
 

 
 
EtherCAT CoE startup command file 
A parameter list can also be exported to an EtherCAT compatible XML format. 
This list can be transferred, for example, as a start-up list to an EtherCAT compliant PLC (COMBICONTROL 
C6, TwinCAT 3.x). 
 
Select parameter list in Navigator → right mouse click → Export → EtherCAT CoE startup command file. 
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9 Scope 

9.1 Characteristics 

• Running of one Scope per project possible, but several scopes can be added and displayed 

• Scope files can be attached to the project or to devices 

• Scope files are saved with the project when it is saved 

• Total up to 16 channels per scope 

• COMBIVERT F5 / B6 / G6: Up to 4 channels per device work in fast Scope mode, (2x32-Bit + 2x16-
Bit) or (1x32-Bit + 3x16-Bit) or 4x16-Bit parameter length. The order does not matter. 

• COMBIVERT F6 / H6 / S6: no fast Scope mode up to firmware version 2.0. From version 2.1 up to 
four 32-Bit parameters can be used in fast Scope mode (Service 21). 

• Display as dot, line, step curve or interpolated curve 

• It is possible to record channels in all devices of the project at the same time 

• Export in XML-format with file extension “.sc6” for import in another COMBIVIS 6 project 

• Export in Excel-compatible “CSV”-format 

• Offline mode (4 channels buffer in one device) 

• Online Trigger mode 

• 2 horizontal and 2 vertical cursors at the same time 

• Extensive zoom-functions 

• Auto scaling function (splaying of the curve to the whole X- and Y-range) 

• Y-axis additionally with parameters unit 

• Import of .sc5-files (COMBIVIS 5) is not possible 
 

9.2 Add Scope to the Project 

Following possibilities are offered for to add a scope: 
 

• A new, empty scope 

• Import an external scope with file extension “.sc6” or “XML” 

• A scope with the same adjustments as an existing 
 

9.2.1 Add a New Scope 

Click on icon    in the tool bar. 
 

 
 
→ Add a new scope: 
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→ Name the new scope and add: 
 

 
 
Alternative way: Right mouse key on “Project” → “Add Object” → “COMBIVIS Scope” 
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Or: in the tool bar: icon “Add Object”→ “COMBIVIS Scope” 
 

 
 
Note: Only one scope can be active at the same time! 
With each scope one recording can be saved with the project. 
Channels and adjustments can be different in each scope. 
 

9.2.2 Open an External Scope 

External stored scopes can be opened in a current project or directly with a temporary project. 
 

In a project click on icon    in the tool bar. 
 

 
 
→ Add a new scope at the project or directly at a device: 
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→ Set hook at import from file → choose the file → open: 
 

 
 
→ Choose to which device the scope channels shall belong → OK 
Selection “New device” adds a new virtual device to the project. This is necessary if there are no device or 
only non-compatible devices in the project. 
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Different channels in the opened scope can belong to different devices of the project. 
The version of the COMBIVERT is stored in the scope, so at opening it is pre-selected if a matching device is 
found in the project. 
 
Directly with temporary project in background: 
Choose scope file in Windows Explorer, then double-click or in context menu “Open with….”  
 

 
 
On Start Page with button “Open Scope” 
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9.2.3 Add a Scope with Similar Settings – Copy Scope 

A second scope may be recorded with the same adjustments later than the first one. So, a comparison can 
be done e.g., after changing of parameters. For that it is possible to copy a scope to a second one identical 
scope. When the new scope is started the old curve will be overwritten. It saves a new channel assignment 
and new adjustment settings. 
 
Copy scope: 
By “copy” and “paste” in the navigator, it is easily possible to create a similar scope. 
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9.2.4 Moving Scope in the project 

A scope can be moved in the project with the mouse pointer. E.g., from the drive to the project or from one 
drive to another. The channel assignment is retained, i.e., the original assignment is not changed or 
adapted. 
 

 
 
The assignment of the channels can be adjusted in the settings of each channel. 
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9.3 Scope Basic Settings 

It is possible to configure basic setting in window “KEB Scope-Settings”. These adjustments will be pre-set 
always when a new scope will be opened. 
 

 
 
Menu bar → “Tools” → “Options” → in window “KEB Scope-Settings” 
 

 
 
In window “Settings” in scope itself settings can be adjusted which are valid only for this scope. 
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Limitation of communication: 
Lock channels: The specified parameter on a channel can be accessed and queried only by Scope. Other 
parameters are accessible. 
 
Exclusive communication: All communication with the devices is limited to the scope. Simultaneous change 
of a parameter is not possible (Also the test run wizard of the x6-devices no longer works). At disabled func-
tion parameters can be adjusted while scope is running and displays changes coevally (e.g., for speed con-
troller adjustment). 
 
In the default setting (both functions off), the communication is split between the read-out scope channels 
and all device parameters visible in other windows. The scope scan rate is therefore faster if all editor win-
dows are hidden. 
 

9.4 Channel Configuration / New Channel 

Channel allocation 
 
In window “New Channel” a parameter can be chosen directly for this channel.  
 

Description for scope 

Trigger option (Identification of special 

occurrences in recording – see there) 

Data channel is reserved only for scope 

Cursors snap into measured value 

Display / design of cursor, grid, and 

legend 

Online (direct display of recorded values 

in CV6) / Offline mode (see there) 

Basis of time axis (X-axis) 

Time gap between two measured points: 

0 = shortest time  
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Alternative: 
 

 
 

Control data of device 

Device reference (-selection) 

(doesn‘t mean device‘s bus ad-

dress!!). I.e., from which device the 

channels shall be recorded 

Parameter group selection 

Parameter selection 

Set selection 

Set addressing mode (di-

rectly or indirectly) 

Acceptance and activation of the 

channel 

Select parameter in device-editor 

and pull it to the window “scope”. 

(Doesn´t matter if scope is in tab 

“display”, “settings” or “new chan-

nel”) 

 

Please do not forget acceptance 

and activation! 

Drag and drop 
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9.5 Channel Settings 

 
 
A disabled (not "enabled") channel is not shown in the display and not recorded at the next recording. 
 
Scaling can be set manually for each channel. 
 

 
 

Channel number 

Optional description 

Channel switched on/off 

Delete channel 

Display channel 

allocation 

Change channel 

allocation 

Auto scaling of this channel 

Parameter value at 0% Y-axis 

Parameter value at 100% Y-axis 

Load default values 

Show unit-axis 

Synchronize with another channel 

Benchmark at 10% of Y-axis (corre-

sponding to 0% / 100%) 
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9.6 Fast Scope Mode 

The fast Scope mode depending on the device type is a possibility of fast and simultaneous transmission of 
measured values. It works like a process data communication 

• COMBIVERT F5 / B6 / G6: Up to 4 channels per device work in fast Scope mode, (2x32-Bit + 2x16-
Bit) or (1x32-Bit + 3x16-Bit) or 4x16-Bit parameter length. The order does not matter. 

• COMBIVERT F6 / H6 / S6: no fast Scope mode up to firmware version 2.0. From version 2.1 up to 
four 32-Bit parameters can be used in fast Scope mode (Service 21). 

Typically, the first chosen channels are placed automatically in fast Scope mode if it is available. 
An assignment of parameters outside the fast Scope mode leads to a considerable slowdown in the record-
ing raster because a time gap must be offered for the additional asynchronous values. 
 
The fast Scope mode works only in direct addressing mode. 
 
The assignment can be changed in menu “channel” → “extended” → “Edit fast scope mode settings”: 
 

Display as stairs 

Display as line, interpolated con-

nection between points 

Display of curve 

Display in points 

Display as line, linear connection be-

tween points 

Interpolation value 

Color of curve 

Measurement value point high-

lighted 

Width of curve 
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9.7 Recording 

Start recording in window “Display” as follows: 
 

• Menu: “Scope” → “Start scope” or 

• Context menu / right mouse key → “Start scope” 

• Tap key “F9” or 

• Click on symbol   
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• “Right mouse key” → “Start scope” or 
 

 
 
Start with “F9”–key works also in other windows of COMBIVIS 6. 
 
Stop with same functions but a stop-icon will be shown:  
 

 
 
Recording time is not limited. Per hour with 4 channels at 15ms cycle time the size will be approx. 90 MB. 
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9.8 Display Window 

Behaviour of the display while recording:  
Context menu / “Right mouse key”→ “Auto-Zoom/Scroll”: 
 

 
 

9.9 Adapt Display 

Time axis (X-axis) 
 

 
 

Saves the current Y-axis 

proportioning for a new 

recording 

At recording the dis-

played window jumps 

with the recorded value 

to the next window 

width 

The window runs synchro-

nous with the actual rec-

orded value 

Scrolling window 

Stretch / compress 

time axis 

Display of full recording time in the window 

Fading in and out 

of cursor value 

schedule 
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X-Axis: Recording time in ms or µs 
 
Y-Axis: Parameter value in basic setting refers to  
   100% = maximum value range 
    0% = 0 
  -100% = min. value range  
 
By passing the curve with the mouse, the actual value will be displayed. 
 

 
 
By right mouse key click on the curve a window opens with adjustment possibilities. 
 

 
 
Stretching / compressing of display after recording: 
Click with “right mouse key” in the display window: “Auto–scale all channels”: 
All actual values will be stretched on the Y-axis all over the window from -100% to +100% 
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9.10 Display – Zoom 

At zooming the relation between the curves is kept. 
 
Zoom to display 0-100% (or rather -100- +100%): 
 - “Right mouse key” → “Fit Zoom level” → “All axes” (or only “X- or Y-axis”) 
 - Tab key F5 (F3 / F4) 
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Zoom by mouse: 

• Whole display with mouse wheel or keys “+” and “-“ 

• Parts of display: mark with left mouse key 
 

 
 
Scaling / fixing of Y-axis: 
Zooming will be done only at the time- (X-) axis by mouse 
Point to the Y-(%-) axis → context menu / “right mouse key” → “Scale fixed” 
 

The view in the window can be 

displaced by using the buttons 

“← ↑ → ↓” 

 

Or: 

Tap key “Ctrl” and left mouse 

key in parallel 

 

Or: 

With pressed mouse wheel 

 

Or: 

Only the time (X-) axis: click 

and hold with mouse and 

scroll to right or left side 

 

Or by button “Auto” on the 

right bottom of the Scope win-

dow 
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Also, a manually scaling of the Y-axis can be done. 
 

9.11 Display – Cursors 

There are 2 vertical and 2 horizontal cursors: 
To integrate: “Right mouse key” → “Cursors” → “Vertical 1 or 2 and horizontal 1 or 2” 
The cursors will be placed in the centre of the display. Displace them by picking with the left mouse key. 
 

 
 
The cursor will always be first placed in the centre. 
The cursor can be moved by pressed left mouse key or by using key combination “Alt+→” and “Alt+” 
 

Alternative with keys: 

Alt+A: Vertical 1 

Alt+B: Vertical 2 

Alt+C: Horizontal 1 

Alt+D: Horizontal 2 
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Calculation mode: 
Based on vertical cursor values, it is possible to realize several calculation types: difference, integral or aver-
age. On basis of horizontal cursor values only difference is possible. 
 
By context menu / “right mouse key” in the cursor list area the calculation mode can be chosen. Or for 
changing click onto the name with left mouse key. 
 

Vertical cursor 1 and 2 

Horizontal cursor 1 and 

2 

Cursor chart: 

Values of the active 

horizontal cursor posi-

tion (Y-axis) or rather 

the intercept point of the 

vertical cursor position 

with the channel curve 

Cursor chart  

visible / hidden 
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With this it is possible to get very easy the RMS current of a drive over a running circuit. 
 
If the cursors are no longer in the picture due to zooming, they can be brought back into the picture with the 
context menu "right mouse button"→ "Centre cursors". 
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The displayed length of the parameter name in the cursor list can be chosen in the context menu: 
 

 
 

9.12 Save Recordings 

Several scope recordings can be added to the project and saved with it. 
Each scope can save one recording (=> 9.2 Add Scope). 
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9.13 Import / Export 

With the export and import function Scope records can be stored outside of the project or external files can 
be imported. The file extension is “sc6”. 
 

 
 

9.14 Export to CSV-Format 

It exports the current diagram into a “CSV”-format. This allows importing the recorded curves in e.g., Excel 
program. 
 

Clears the display 

Copies the displayed picture to 

the clipboard 

Can be used e.g., in MS-Office 

programs 

Imports a CV6 scope file, the 

actual displayed curves will be 

erased 

Exports the actual scope curves 

in a sc6 or a CSV-format e.g., 

for saving 
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Adjustments of “CSV”-format by: “Tools” → “Options” → “KEB-Scope” → “Extended” 
 

9.15 Trigger Function (Online) 

Trigger function in online mode 
 
This function realizes in case of long-term recordings a limitation of the saved period (e. g. period around a 
defined error occurrence). Therefor a trigger event will be defined (e.g., a special drive controller status or a 
reached current level). 
 
Around this event a predefined time domain will be saved. That results in a compact scope-file also for long 
term recordings. 
 
This function will be adjusted and activated in the window “Scope” → “Settings”. 
 
The trigger event will be placed in scope display at 0 ms on the time axis. 
 
Triggering (Online Mode) 
 

1.) 

Exports the current scope 

curves in a CSV-format. 

2.) 
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Example: 
 

 
 

9.16 Offline Mode 

The Offline mode uses the function of the fast Scope mode’s 4 channels to buffer parameter values in the 
device. Therefor a part of the device’s storage is reserved. 
Via channel allocation recording and filling of storage will be generated. The storage works like a drum store, 
each new value overwrites the oldest one. 

Over travel time, saved time 

after trigger event 

Level, absolute relating to unit 

or percentile relating to range of 

values 

Lead time: Saved time before 

trigger event 

Activate trigger function 

Trigger channel: On which 

channel shall be trig-

gered? 

Which trigger pulse edge or 

level? 

Trigger 

Delay Lead-time 

Trigger level 
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The store will be frozen by a trigger event and can be read-out by scope. Because of a faster data communi-
cation in the devices than to the PC it can be recorded with a shorter time grid. 
Useful for: 

• Shorter time grid, therewith better hit rate in short peaks  

• Recording without PC 

• Recording of sporadically events  
 
Characteristics: 

• Available for COMBIVERT F5 but not F5-Basic, B6, F6, G6, H6, S6 and P6 drive controllers 

• Contrary to online mode data won‘t be readout sequential from the drive controller and displayed but 
internally saved in the drive controller 

• No dependency on communication time, therefore very short frames realizable  

• Up to 4 channels in one device will be recorded with chronological synchronism and in a fixed frame 
(fast Scope mode)  

• For data recording a connection drive controller to PC must not be active 

• Flexible trigger conditions allow a selective recording of sequences 

• Trigger will be released by a digital input. 

• Also, after drive controller‘s power-off the trigger requirement will remain unaffected (only F5-A/M, -
S, -H, -K, -L, -P, -E ≥ D-housing). In COMBIVERT G6 the trigger condition will be saved after Power-
Off, stored date will be lost. It is possible to trigger intermittent effects over a long period. 

• At COMBIVERT F5, B6 and G6 all Parameters are recorded only from set 0. 
 
Note: With COMBIVERT H6/F6/S6/P6 up to firmware 2.7, the index values of ARRAY and STRUCT param-
eters cannot be recorded. This function is only possible with COMBIVERT F6/S6 from firmware 2.8. 

9.16.1 Switch On and Adjustment of Time Basis 

Activating of Offline mode: “Scope” → “Settings” → “Mode” 

 
 
Adjust scanning-frequency: 
Maximum number of buffered values * scan time = stored time. 
That means: the smaller time base the shorter recorded time. 

Read out of a stored record-

ing. 

Channel allocation will be read 

out automatically  
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Max. quantity of values depends on controller‘s data space (=>: 9.16.5 Offline-Storage Capacity). 
 
Note: For COMBIVERT H6/F6/S6/P6/T6 the sampling rate depends on the setting in parameter is22 / time 
base Tp. Only multiples of the time base set in is22 can be used (rounded if necessary). 
 

 
 

9.16.2 Adjusting of Trigger Source 

Digital inputs act as trigger source.  
The activation of inputs initiates a saving of the scope recording. 
Via software inputs IA … ID complex trigger requirements can be indirectly realized by outputs OA … OD 
(COMBIVERT F5/B6/G6). 
E.g., setting “F” for recording of acceleration 
Or: by Out switching condition: “current > level” to input IA 
 

 
 
Sample for COMBIVERT F5 (similar at G6): 
A description and 2 samples can be found by menu “Help” → “Show “FAQ” Documents” → “FAQ CV6 0003 
OfflinescopeTriggerConditions (en)”. Also 2 sample parameter lists are included. 
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9.16.3 Adjusting of Trigger Position 

Trigger position defines how many percent of the complete recording period before trigger event shall be dis-
played. 
Example 20%: 
= 20% of recording indicate the period before the trigger event. 
 

 
 
Remark: 
When the recording is started, the offline memory (ring memory / drum storage) is filled with values. Until the 
memory has finished the first loop values from previous records can be in. If, after the start of the recording, 



Scope 

138   © 2022  KEB Automation KG 
     

 

the trigger still comes within the first “round” and has only a little delay, it may be that the previous values 
have not yet been overwritten and are displayed. 
 

9.16.4 Applying Offline Mode 

• Start offline recording via click on start/stop button    or tap key “F9”.  

• In the bottom of the scope-window the flashing code “wait for trigger” appears. The drive controller 
waits for the trigger event. 

• The code will change into “data recording” as soon as the trigger event occurs. The recording will be 
realized and saved. 

• If the saving process is finished, the code will change into “offline data readout”. The saved data will 
be red out by Scope and displayed.  

• After reading out the diagram can be handled like in online-mode. 
 
Recording without connected PC and read out afterwards 

• Start offline recording by start/stop button    or tap key “F9” → at the bottom of the display is 
shown blinking “Wait for trigger”→ the device is waiting for the trigger condition 

• Close COMBIVIS 6 without stopping the scope, if applicable save project.   

• When the first trigger condition occurs, the curves will be saved in the device´s storage. Further will 
be ignored. 

• Connect cables as shown before → start COMBIVIS 6 with the respective or with a new project → if 

needed get connection to the device → at “Scope” → ”Settings” click on:  
→ the saved data will be read out of the device and displayed in Scope. 

• The saved data will be erased at F5-A/-S/-E/-H; ≥D-housing only by a new starting of offline record-
ing. The drive controller can also be switched of in the meantime. At G6/ H6/ F5-A-Servo (A-Hous-
ing) trigger requirements and saved data will be erased also by switching off the device or by over-
writing. 

 
For example: 
Time base: 500µs / trigger source: F / trigger position: 5% 
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9.16.5 Offline-Storage Capacity 

E.g., in KEB COMBIVERT F5.A Version 4.2: ≥ D-housing: 
For 1x or 2x 16-bit-parameters:    approx.1900 values/channel 
For 3x or 4x 16-bit-parameters:    approx. 950 values/channel 
For 1x or 2x 16- and 1x or 2x 32-bit-parmeters: approx. 470 values/channel  
(32-bit-parameters are e.g., position, torque, and control / status word long…) 
 
Therewith 4 channels with 16-bit in 0.5ms time basis give approx. 0.47s recording time. 
For the other drive controllers this might differ strongly. 
For example: a KEB COMBIVERT G6-G has approximately 20% more space. COMBIVERT F5-C has ap-
prox. 70% less and COMBIVERT B6 approx. 86% less. 
 
  

Trigger 

5% 95% 
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10 Start-up Assistants (Wizards) 

Start-up wizards are tools for an easy creating of parameter lists and parameter adjustments. 
 
Two procedures of start-up wizards can be found: 

• Online start-up wizards – all adjustments are done directly in the device. 

• Offline start-up wizards – creates a parameter list, which can be stored or directly downloaded to the 
device. 

• Only the compatible wizards will be offered in the project. 

• For “generation 5” drives (type F5, B6, G6) online and offline wizards can be found. 

• For “generation 6” drives (type F6, H6, P6, S6, T6) an online wizard is offered. It can be used offline 
partly. At next connection to the drive the values will be transferred to the drive. 

 

10.1 Online Start-Up Wizard 

Online wizards need a connected device because all adjustments are done directly in the device parameters. 
 

10.1.1 Online Start-Up Wizard COMBIVERT F6/ H6/ S6/ P6/ T6. 

For the new “generation 6” drive controller a step by step start-up online wizard is implemented. 
It can be used also offline but then not all features can be handled. 
The idea is to start-up the drive with handling of all necessary adjustments step by step. 
Depending on the functions available in the device type, parts of the wizard are masked. 
For each function card there is a tab “expert settings”. There, the parameters belonging to the respective 
function are listed directly and allow advanced settings. The normal user is passed over it and normally does 
not need to set anything. 
 

10.1.1.1 Basic Settings 

• Backup / restore to backup 
The backup is saved with the project. A saved backup file can be exported as parameter list to the 
navigator and from there exported out of the project. 

• Device reset to factory default: 
At reset the CPU is restarted, so COMBIVIS loses contact for a short time. 

• Process data disabling, reconnect with former adjustments: 
With active process data, the controller can overwrite certain parameters again and thus make a 
manual adjustment impossible. This function only works with COMBIVERT F6-K, S6-K and H6. 

• Device clock: 
The clock has no runtime reserve, also no connection to the clock of the safety module (option). 
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10.1.1.2 Motor 

• Can be used for synchronous and asynchronous 3-phase motors 

• Data of KEB Motors can be chosen by Part. No. 

• Motor data can be adjusted manually, and the data can be stored in a motor data base (after identifi-
cation in window “Identification”) 

• Data from user motor database can be chosen. 

• User data base can load or exported 

• Adjustment of braking transistor  

• Adjustment of temperature sensor type and fault reaction 

• Data of brake and sinusoidal filter can be adjusted optimally 

•  
Leaving of the window “motor” activates the motor data in the drive controller. 
 

Create backup 

Disable process data (only F6-K, 

S6-K, and H6) 

Set clock, manually or by PC 

clock 

Delete backup, download to the 

device or export to the navigator 

as parameter list  

Load backup to the device 

Set device to default 
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10.1.1.3 Feedback Mode 

Adjustment of  

• Feedback mode (v/f-mode/open loop, closed loop, encoder less closed loop) 

• Encoder interface 

• Encoder type and data 

• At encoders with electronic type plate motor the data can be red out of the encoder (KEB Motor) 
At synchronous motors, the v/f-mode is not available 
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10.1.1.4 Controller 

• Adjustments for speed controller  

• Adjustments for position controller and position feedback. 

• Pre adjustments depending on the inertia of motor and machine. 
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10.1.1.5 Protection / Warnings 

• Adjustments for status word 

• Adjustments for warning levels 

• Application dependent warnings 

• Adjustments of error reaction ramp 
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10.1.1.6 Identification 

• Guided motor data identification 

• Must not be done at KEB motors selected by KEB Motor database 

• Identified motor data can be stored in user motor database 
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10.1.1.7 Modes of Operation 

• Mode of operation regarding CiA 402 can be chosen. 

• Adjustments depending on the chosen mode can be done. E.g., ramp mode, s-curves, speed limits, 
position curve settings, homing methods… 

 

 
 

10.1.1.8 Fieldbus 

• Selection of bus system 
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• Size of process data 

• Process data adjustments 

• Bus diagnosis 

• Create and export of device description 

• Save and handle of self-created mappings 
 

 
 
Selection of the bus system: 
Depending on the hardware of the device the bus type can be selected: 
 

 
 
At EtherCAT and Profinet the process data size can be chosen (depending in firmware version): 
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i  ➢ If the bus type is changed, an error is triggered in the drive (ru01 = Error! 
fieldbus type changed). The change must be confirmed by pressing the "soft-
ware reset" button or a power-on reset of the unit. Only then will the change 
be accepted!  

 

 
 
Assignment of process data: 
The wizard offers a standard process data assignment: 
“Stored Mappings” → “KEB database” → “Load” → select device type 
The process data will be loaded and activated. 
 

 
 
A customer specific assignment can be stored in the user data base and can be reloaded. 
“Stored Mappings” → “User database” → “Load/Save” 
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Manual assignment: 
The process data must be disabled! 
The right-hand window lists the parameters available for process data. 
These can be copied with the mouse to the Transmit PDO field or the Receive PDO field using drag & drop. 
The data length is taken over correctly. 
Parameters can be deleted by dragging them to the waste basket at the bottom left via the mouse or marked 
and using the “Delete” key. 
“Read only parameters” cannot be dragged into the Receive PDO field. 
The number of transferred objects can be restricted. This allows certain objects to be excluded from data ex-
change from right to left.

 
 
Device description file: 
With the wizard, the device description file can be generated depending on the selected bus type. 
At CAN and EtherCAT, this contains the current process data assignment. 
 
EtherCAT EDS: 
“EtherCAT” → “Export device description” 
 

Number of active PDOs 

Assignment of transmit pro-

cess data 

Assignment of receive pro-

cess data 

Enable process data 

Parameter available for pro-

cess data 



Start-up Assistants (Wizards) 

150   © 2022  KEB Automation KG 
     

 

 
 
If the KEB COMBICONTROL is available, the description can be loaded directly: 
 

 
 
For an EtherCAT PLC this can be generated and saved: 
 

 
 
The FSOE process data description can additionally be selected for the KEB Safety Modules: (=> manual of 
the respective device) 
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Profinet: 
The device description file GSDML can be found in the KEB document database in the "Software" area un-
der the part number of the COMBIVERT: 
 

 
 
CAN EDS: 
In the CAN process data wizard, an EDS device description file can be created and saved: 
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Ethernet IP EDS: 
The EDS device description file can be found in the KEB document database in the "Software" area under 
the part number of the COMBIVERT or the term “Ethernet”: 
 

 
 
Powerlink xdd: 
In the Powerlink process data wizard, the xdd device description file can be created and saved: 
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10.1.1.9 Test run 

The Test run wizard can be opened in a separate window. 
It enables a motor run or positioning step from the PC, without having to have a separate control. Likewise, 
the state of the state machine is graphically displayed. 
 

 CAUTION 
 The test run wizard does not have any watchdog functionality! 

If the communication is lost due to cable interruption or program crash, 
the drive continues to run with its last set points! 
 

➢ Therefor always implement a separate, communication-independent, 
possibility to stop the drive. For example, by a separate, wired switch 
for control release or STO or mains voltage. 

  

 

 
 
It can be arranged parallel to the device editors. You can then switch conveniently between e.g., Scope and 
the test run wizard: 
Click the header with the left mouse button, hold it down and move the mouse pointer to the appearing ar-
rangement cross, place it in the middle field and release the mouse pointer. 
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State machine 
The view for the state machine can be opened with the field "status display" arranged in the top right corner. 
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The state machine graphically displays the state of control word co00 and status word st00. 
In Control Word, each bit can be set individually by clicking on the green dots. 
You can also use the direct buttons below. 
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Velocity mode: 

• pre-set of 3 speeds 

• setting of control word 

• setting brake control bit 

• start of pre-set scope 
 

 
 
Profile position mode 
The drive can be moved in relative or absolute position profile: 

• pre-set of 4 positions 

• setting of control word 

• setting brake control bit 

• start of pre-set scope 
 

Actual speed 

Display of current state like STO, 

fault, supply  

Switch brake – Bit 15 in control 

word (parameter co00) 

Adjustment of drive mode (parameter 

co01) 

Actual set speed (parameter vl20) 

Activate pre-adjusted speed in 

(parameter vl20) 

Pre-adjust target speed, += right, -= 

left direction 

Start pre adjusted scope 

Start / Stop - Enable operation 

in the state machine 
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Note: with "relative position" and "change target position immediately = off", a positioning profile is generated 
with each mouse click on the field "Start positioning" and then processed one after the other! 

 

Homing Mode 

Set the current position to 0 

Actual speed 

Display of current state like STO, 

fault, supply. 

Switch brake – Bit 15 in control 

word (parameter co00) 

Actual position of the drive  

Adjustment of drive mode (parameter 

co01) 

Positioning speed for the next 

profile (parameter ps30) 

If the drive must stand still before start 

of the positioning profile set “0” speed 

(parameter vl20) 

Start / Stop - Enable operation in the 

state machine 

Hook: Relative positioning 

No hook: Absolute positioning 

Hook: The profile will be interrupted, and 

the new target will be headed 

No hook: The current positioning profile 

is ended and then the new destination is 

activated. 

Set pre-defined position into parameter 

co19:“target Position” and start position-

ing 

Go to position “0” 

Pre-defined Scope starts 

Pre-defined target position 
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In many cases, the current mechanical position of the drive must / should represent the zero point. How to 
set the current position to 0: 

Set mode to “homing mode” 

• The homing method must be set to "35: on current position" (default). The parameter hm01 is 
included in the expert settings. 

 

• Enable the bit “Start homing” in the Control Word and disable the bit. 
 

 
 
The other modes cannot be used or only with restrictions by the test run wizard. 
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10.1.1.10 Cogging 

The cogging compensation function minimizes the permanent magnet depending unequal speed in the 
range of low speed. Therefor the wizard measures a torque curve, calculates the offset curve, and saves the 
values in the drive controller. 
 

 
 

• Useful only for permanent magnet linear drives and permanent magnet synchronous motors 

• The calibration requires a motor encoder with position signal (e.g., resolver). The function itself can 
also work without an encoder with a loss of quality. 

• The measurement may be done only after optimal adjustment of speed and position controller of the 
drive controller.  

• The motor must run without load! 

• Depending on the motor size and construction pre-adjustments in the wizard may be changed. 

• During measurement, no value may be changed manually or by bus system 

• The wizard uses the profile position mode 

• The measurement takes 20-30 minutes 

• After ending of the measurement, the result must be transmitted to the drive controller and the func-
tion must be enabled. 

• The measurement procedure can be interrupted. If no value is transmitted and activated there is no 
influence on the drive controller. 

 
The “target reached” mode controls the measurement via a positioning profile and ensures that really each 
measurement position is approached. That provides an accurate result but requires well-adjusted speed and 
positioning controls. 
 
The “time-based” mode controls the measurement over a time sequence of measurements, regardless of 
whether the position has been reached or not. The result is not so accurate, but works more easily, because 
the movement does not have to be so precise. 
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After the measurement is done, the data must be transferred to the drive and activated: 
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The result of the measurement is displayed in the editor “Graphs and data”. It can be stored in a separate file 
and reopened later. 
 

 
 

10.1.2 Online Start-Up Wizard Basic COMBIVERT F5, B6 and G6. 

For all COMBIVERT F5, B6 or G6 a small startup wizard is available: 
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10.1.3 Online Start-Up Wizard COMBIVERT F5. 

10.1.3.1 Motor Data Identification F5-A/ -K and F5-H/ -L (ASCL) 

For driving with asynchronous motors, a wizard for motor data calculation and measurement is available. It 
works only with F5-A/ -M/ -K from V4.3 or F5-H /-L from V2.3. A standard mode and an expert mode are 
available. Specific values which are to be changed for measurement (set value…) are saved before and set 
back after finishing of the measurement.  
The description of the motor identifying function can be found in the application manual F5-A (=> 13 Docu-
ment Database). 
 
The control release terminal must be switched open and close while identifying runs. Switching by software 
is not possible. 
 
Open in device editor: 
 

Set factory default 

(fr01= -4) 

Copy all values of 

one set / subindex to 

another set / subin-

dex 

Adjust control and 

speed mode  

Copy set 0 / subin-

dex 1 to all sets / 

subindices 
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With expert mode some useful adjustments are offered: 
 

 
 
In the tab "Expert settings" all relevant parameters are available as an online list and can be adjusted manu-
ally if required such as the parameter editor: 
 

Adjust motor 

data 

Display of actual 

measured data or 

status 

Adjust speed 

mode 

Start identification 

with automatic 

procedure  

Enable expert mode 

Full selection of 

identification options 

Manually adaption 

of filter settings 

Open list with man-

ually adjustable pa-

rameters 

Adopt best settings 

Expert mode enabled 
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10.1.3.2 Motor Data Identification F5-A/ -S/ -K and F5-E/ -P (SCL) 

For driving with PM-synchronous motors with and without encoder a wizard for motor data calculation and 
measurement is available. It works only with F5-A/ -S/ -K from V4.3 or F5-E /-P from V2.3. A standard mode 
and an expert mode are available. Specific values which are to be changed for measurement (set value…) 
are saved before and set back after finishing of the measurement.  
The description of the motor identifying function can be found in the application manual F5-A. => 13 Docu-
ment Database. 
 
The control release terminal must be switched open and close while identifying runs. Switching by software 
is not possible. 
 
Open in device editor: 
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With expert mode some useful adjustments are offered: 
 

 
 
In the tab "Expert settings" all relevant parameters are available as an online list and can be adjusted manu-
ally if required such as the parameter editor: 
 

Adjust motor data 

Or: 

Display of actual 

measured data or sta-

tus 

Adjust speed mode 

Start identification 

with automatic pro-

cedure 

Enable expert mode 

Routing to motor 

data assistant (see 

10.2.1.1 Motor con-

figurator) 

Full selection of 

identification op-

tions 

Manually adaption 

of filter settings 

Open list with man-

ually adjustable pa-

rameters 

Adopt best settings 

Expert mode enabled 

Stabilizes start  

Extra menu for rotor 

position detection 
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10.1.3.3 Start-Up assistant F5 with Profinet 

By the assistant for process data adjustment on an easy way the PDO assignment can be done. In standard 
mode most device parameters can be placed by Drag&Drop from device editor to the assistant. 
Using the wizard for the process data assignment can be done in a simple way the PDO assignment. In 
standard mode, certain device parameters can be pushed by Drag&Drop from the Device Editor into the ap-
propriate fields of the wizard. It is an operator firmware version 2.9ff required. 
 

 
 

Push parameter with 

pressed left mouse key to 

the tab “Online Wizard” 

and hold… 
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A changing can be done only in condition “Inactive PDO”. 
 
In Expert mode the PDO assignment can be done manually by hexadecimal addresses. 
=> also: 10.2.1.4 Process data adjustment of F5 Profinet Operator 
 

10.1.4 Online Start-Up Wizard COMBIVERT G6. 

10.1.4.1 Motor Data Identification G6-L (ASCL) 

The online start up wizard basically works the same as F5-ASCL: => section 10.1.3.1 
Because of no encoder can be connected, there will be no encoder parameter in the selection. 
 

10.1.4.2 Motor Data Identification G6-P (SCL) 

The online start up wizard basically works the same as F5-SCL: => section 10.1.3.2 
Because of no encoder can be connected, there will be no encoder parameter in the selection. 
 

10.1.5 Start-Up Wizard COMBIVERT T6. 

A separate commissioning assistant will be published for the COMBIVERT T6 during the term of CV 6.6.0. 
This is only integrated in COMBIVIS studio 6, since the start-up works with the integrated embedded PLC. 
The “inverter-specific” parameters can be addressed with the online start-up wizard. The description is in 
Online Start-Up Wizard COMBIVERT F6/ H6/ S6/ P6/ T6. 
 

10.2 Offline Start-Up Wizard 

For an offline Start-up wizard, it is not needed to connect a device. 
The result can be loaded directly into a connected device, or a list of data (parameter list or another file) can 
be created, that can be saved and load into the device later. 
 
Open start-up wizards: 
If there is a wizard for the device software offered, it will be shown direct in the navigator window. 
 

Push parameter with pressed 

mouse key to the field “Transmit 

/ Receive PDO” and lay down 
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If it isn´t shown because e.g., the software mode has switched, the start-up wizard can be opened manually: 
Mark device → right mouse key → “Add object” → “Start-up Wizard” 
 

 
 

Or: mark device → Tool bar: Icon  → “Start-up assistant” 
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Give name and add. 
 

10.2.1 Offline Start-up Wizard for COMBIVERT F5. 

10.2.1.1 Motor Configurator F5-S 

The motor configurator is available in mode for Pm-servo motors F5-S, F5-P, F5-E und G6-P.It creates a pa-
rameter list with related motor data based on the KEB synchronous motors or self-defined data. This list can 
be stored or direct loaded to the device. Currently only synchronous motors are available. 
 
The self-defined motors are stored in a separate file. This can be copied to other PCs: 
C:\Program Files\KEB\COMBIVIS_6\KEB\UserMotors.xml 
 
Motor from KEB-database: 
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Choose motor, e.g., B1SM000-6200: 
 

 
 
Define your own synchronous motor: 
 

Forward 

Reduction of list for 

design, voltage, 

speed, pole number 

Forward Back 

Adjust design of cooling type 

Adjust encoder type 

Pre-adjustment of speed con-

troller: 2=strong, 15=weak, (ba-

ses on motor inertia) 
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In → Overview it can be chosen if the parameter would be load directly into the device or if a parameter list 
shall be created. 
 

10.2.1.2 Process Data Adjustment of F5 CAN Bus Operator 

The F5-CAN bus wizard mainly may be used for creating the CAN EDS file. An adjustment of the process 
data can be done but a download of the settings into the device is not possible. 
The function of the assistant is like the assistant of G6-CAN, => 10.2.2.1 Process data adjustment G6 CAN. 
 

10.2.1.3 Process Data Adjustment of F5 EtherCAT Bus Operator 

The Process data assignment for the F5-CAN operator can be created and thus an XML- file. However, a 
download setting in the device is not possible. 
The function of the assistant is like the assistant of G6, => 10.2.2.2 Process data adjustment G6 EtherCAT. 
 

10.2.1.4 Process Data Adjustment of F5 Profinet Operator 

Using the wizard for the process data assignment can be done in a simple manner the PDO assignment. In 
standard mode, certain parameters of the wizard can be dragged by "drag and drop" from the Device Editor 
in the appropriate fields. There is an operator firmware version 2.9ff required. 
 
By “Upload” the adjustments of the device will be transmitted to the assistant and displayed. 

Enter motor name 

Put motor data into 

motor list 

Use motor data directly for 

parameterization 
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By “Download” the adjustments of the assistant can be transmitted to the connected device. 
 

 
 
In the Expert mode the PDO assignment can be done manually by hexadecimal addresses. 
 

 
 
In → Overview it can be chosen if the parameter would be load directly into the device or if a parameter list 
shall be created. 
 

Assistant for Profinet mapping 
Pd-mapping with 

“Drag&Drop” 

Own data sets can be created, red or 

deleted 
Load mapping from or into device 

Enable expert mode 
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10.2.2 Offline Start-up Wizard for COMBIVERT G6. 

10.2.2.1 Motor data configurator G6-P 

The Motor data configurator works in the same way as the 10.2.1.1 Motor data configurator F5-S. Because 
of no encoder can be connected, there will be no encoder parameter in the download list. 
 

10.2.2.2 Process Data Adjustment G6-CAN 

Using the wizard for the process data assignment can be done in a simple manner the PDO assignment. In 
standard mode, certain parameters of the wizard can be dragged by "drag and drop" from the Device Editor 
in the appropriate fields. 
 
By “Upload” the adjustments of the device will be transmitted to the assistant and displayed. 
By “Download” the adjustments of the assistant can be transmitted to the connected device. 
By “CAN EDS” an EDS-file matching to device and PDO assignment will be created. 
 

 
 
With “Configuration database” can be loaded into the wizard a previously saved setting or the KEB default. 
The KEB default loads the assignment for the CiA 402 profile in the wizard. “Save” can save an own assign-
ment. 
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In the Expert mode the PDO assignment can be done manually by hexadecimal addresses. 
 

      
 
In → Overview it can be chosen if the parameter would be load directly into the device or if a parameter list 
shall be created. 
 



Start-up Assistants (Wizards) 

© 2022  KEB Automation KG   175 
     
 

10.2.2.3 Process Data Adjustment G6-EtherCAT 

Using the wizard for the process data assignment can be done in a simple manner the PDO assignment. In 
standard mode, certain parameters of the wizard can be dragged by "drag and drop" from the Device Editor 
in the appropriate fields. 
 

 
 
By “Upload” the adjustments of the device will be transmitted to the assistant and displayed. 
By “Download” the adjustments of the assistant can be transmitted to the connected device. 
By “device description” an XML or ESI-file matching to device and PDO assignment will be created. 
 

 
 

Assistant for EtherCAT mapping 
Pd-mapping with 

“Drag&Drop” 

Own data sets can be created, 

red or deleted Load mapping from or in device 
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By “PdIn Details” und “PdOut Details” a detailed adjustment of Pd-mapping is possible. 
 

 
 

10.2.3 Offline Start-up Wizard for COMBIVERT F6/ H6/ S6/ P6/ T6. 

There are no offline wizards for COMBIVERT F6/ H6/ S6/ P6/ T6. The Online wizard can be use with re-
strictions also offline. 
 

Create ESI-File 

Save as external file 

Create XML-File 

Create MDP-

File 

Install in device storage (only by 

COMBIVIS studio 6) 
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10.2.4 Offline Start-up Wizard Overview 

 
 
  

Create and export a pa-

rameter list with all pa-

rameters of selected wiz-

ards 

Create a parameter list 

with all parameters of se-

lected wizards 

Do a download to the device with 

all parameters of selected wizards 

Choose which parameter of 

which wizard shall be used for 

listing or download 
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11 Help Area 

There are 4 help areas: 

• Help for specific COMBIVIS- or Device functions 

• Help for COMBIVIS program functions 

• Help for certain device functions (FAQ) 

• Help for  device parameter functions 

 

11.1 Help for Specific Functions 

By touching with mouse on the sign  the corresponding help or explanation text is briefly displayed. 
 

 
 

11.2 Help for Program Functions 

By pressing the F1 key in a particular program function the user will jump to the corresponding location in the 
manual. 
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In the menu bar under "Help" the help function can be opened in different display modes. 
 

 
 
There is a distinction between function of COMBIVIS 6 and the programming system CODESYS. 
 

Searching function in help function 

View of whole manual 

Tag overview 

Open manual of COMBIVIS 6 in PDF 

format 
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11.3 Help for Certain Device Functions (FAQ) 

For certain procedures descriptions or samples are available. 
Menu "Help" → "Show COMBIVIS 6 “FAQ” documents” 
 

 
 
The KEB document database with file type FAQ opens. Depending on the program or device type descrip-
tions or sample parameter lists are displayed. Files or sample lists can be opened directly by double-clicking.  
 

See special function descriptions 
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11.4 Help for Parameter Functions 

COMBVIS 6 allows direct access to the device documentation. Requirement is that the documentation was 
imported from the KEB website into COMBIVIS 6. The feature is available only for registered COMBIVIS 6 or 
licensed COMBIVIS studio 6 versions. A PDF viewer is required. KEB suggests when installing COMBIVIS 6 
free program PDF X-Change Viewer to installation. 
 
When the corresponding Programmer's Guide is installed, with the function context menu - "Find documenta-
tion ..." the declaration of the parameter will be shown. 
 

 
 
The programming manual of the device opens by PDF-X-Change Viewer: 
 

Show in KEB documents explana-

tion for parameter 

“Right mouse key” 
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In the right part of the window all digits are displayed where the selected parameter appears. The selection 
of a reference leads to a jump to the location in the PDF document. 
 
The direct opening and the import of documentation are described in chapter 13 Document Database. 
 

11.5 COMBIVIS Error Messages 

COMBIVIS shows errors in message window or instead of the parameter value. 
 

Value  Name Source Note 

-200 
Exception 
caught 

Driver (COMBIVIS in-
ternal) 

An unexpected error occurred in the telegram pro-
cessing 

-110 
Invalid  
service  
parameter 

Driver (COMBIVIS in-
ternal) 

Invalid encoding of request 

-109 
Channel does 
not send 

Driver (COMBIVIS in-
ternal) 

Message could not be sent (e.g., port not available) 

-108 
Channel  
locked 

Driver (COMBIVIS in-
ternal) 

The channel is used by another component 

-107 BCC error 
Driver (COMBIVIS in-
ternal) 

Transmission error (response of the device incorrectly 
received) 

-106 
Invalid  
protocol 

Driver (COMBIVIS in-
ternal) 

Invalid encoding of the response telegram 

-105 
Service 
decoding un-
supported 

Driver (COMBIVIS in-
ternal) 

Invalid encoding of request 

-104 
Service 
encoding un-
supported 

Driver (COMBIVIS in-
ternal) 

Invalid encoding of request 
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-103 
Invalid node 
address 

Driver (COMBIVIS in-
ternal) / Gateway 

Invalid node address 

-102 
Invalid invoke 
id 

Driver (COMBIVIS in-
ternal) 

Invalid encoding of the response telegram 

-101 
Invalid re-
sponse re-
ceived 

Driver (COMBIVIS in-
ternal) 

Invalid encoding of the response telegram 

-100 
Channel 
closed 

Driver (COMBIVIS in-
ternal) 

Channel is closed / in parameter list: wrong device ref-
erence 

-10 No Answer 
Driver (COMBIVIS in-
ternal) 

No response was received within the timeout period 

0 OK Target device OK 

1 
Device not 
ready 

Gateway 
The target device cannot be reached (error code is 
typically reported by a gateway component, e.g., 
USB-converter, Operator, Port Expander …) 

2 
Invalid ad-
dress or pass-
word 

Target device /  
Gateway 

Password to access level is insufficient 

3 Invalid data Target device Data are invalid (e.g., out of range) 

4 
Parameter 
read only 

Target device Parameter can be red only 

5 BCC error Target device 
Transmission errors (The request is incorrectly re-
ceived at the device) 

6 Device busy Target device 
The device is reachable, but busy (e.g., reset, etc.) 
and will be available again soon 

7 
Service not 
available 

Target device /  
Gateway 

Service is not supported (may be reported by the de-
vice or a gateway component) 

8 
Invalid pass-
word 

Target device /  
Gateway 

Password level for access is insufficient 

9 Invalid frame 
Target device /  
Gateway 

Invalid encoding of the telegram 

10 
Invalid 
 character 

Target device /  
Gateway 

Invalid encoding of the telegram 

11 
Invalid 
set/subindex 

Target device /  
Gateway 

Set (at Service 0) / subindex (with Service 14) not 
available  for this parameter 

13 
Invalid ad-
dress 

Target device Invalid parameter address 

14 
Function not 
possible 

Target device /  
Gateway 

Function not possible (in the current state of the de-
vice)     e.g., control release is enabled 

 
Additional error messages: 
At opening of a project, a pop-up with following error message comes: 
“……C:\Programdata\COMBIVIS6\......COMBIVIS6ProjectDefaults.opt could not be loaded” 
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At last saving of the project of the belonging “.opt”- files is damaged or empty. This file store the personal ad-
justments of the user (language, window size etc.) for this project. They do not influence the content of the 
project. The files are newly created at every storing of the project. Thus, they can be deleted: 
The path is shown in the error message. “Program Data” is a hidden folder. If it is not shown it must be made 
viewable in the folder options: 
 
Windows 10: 
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A re-installation of COMBIVIS will not help, because the damaged file will not be deleted by the de-installa-
tion procedure! 
 

11.6 TeamViewer 

COMBIVIS provides a simple TeamViewer version. TeamViewer is a program with which a participant gets 
access to another PC over the Internet, sees the image surface, and can operate it. 
The computer with COMBIVIS must have a sufficiently fast internet connection. 
 
The owner of the "observed" PC must explicitly start the program and agree to access. The remote access 
can only be made with a licensed full version with the same or higher version. 
The COMBIVIS TeamViewer cannot access another PC. 
Access is not limited to COMBIVIS. 
Each time a new call is made, the password is changed. 
 
Start: 
Menu “Help” → “KEB Quick Support” 
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Agree to the disclaimer: 
 

 
 
Tell ID and password to the user of the PC to be switched on: 
 

 
 
At the bottom the status of the connection is shown. 
 
A recording of the session can be made: 
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The control and properties window is displayed: 
 

 
 
For quit and close click on the “X”. 
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12 Search Function 

COMBIVIS 6 offers two different search functions. 
 

12.1 Searching for Text 

The general text search under the “binoculars” in the tool bar (only in COMBIVIS studio 6): 
 

 
 
Here is just looking for texts in specific fields. 
 

12.2 Searching for Parameters 

The parameter search is opened with Ctrl + Shift + F or the icon in the toolbar. Parameters can be searched 
in the Device Editor and parameter lists in the project. 
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Normally, the searching of parameters is done from the current cursor position is to the end. When the de-
sired parameter is before it is not found. With the "end from the beginning" option the parameter will be 
found, but it may be in a loop and the user must decide at which point the loop is executed. 
 
Can be searched by: 

• Parameter ID (abbreviation). Search field must be set to “IdTxt”. (Parameter Id without dot). 

• By Parameter name: e.g., “current” all-the parameters will be found with the term “current” in the 
name 

• By hexadecimal address: 1234h or 0x1234 
 

 
 
Search methods:  
In “Find Next” will jump to the next location in the display window. 
 

Text to search 

Searching array 

Shows all results in separate window 

“Parameter search results” at the bot-

tom of CV6 window 

Jumps to the next search result 

Text mode 

Terms for searching 
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In “Search All” a new result window will open with all the localities in the message window. Clicking the lo-
cality in the results executes a jump to the appropriate place in the editor or in the parameter list. 
 

 
 
  



Document Database 

© 2022  KEB Automation KG   191 
     
 

13 Document Database 

By the COMBIVIS internal document database all KEB documents can be displayed. In the basic equipment 
the programming manuals of COMBIVERT F5-A, G6 and F6/H6/S6 are integrated. Other documents (manu-
als, catalogues, E-Plan-data….) can be added via internet. 
 
The using of the database requires the registration of COMBIVIS 6 or the licensing of COMBIVIS stu-
dio. The registration can be done via button on the bottom of the start page or via menu bar: “Help” → “Reg-
istration”. The Registration is for free. 
 

13.1 Add and Delete KEB Documents 

The documents are grouped in packages. Documents are updated via the auto-update function. For the in-
stallation or update an Internet connection to KEB website www.keb.de is required. 
The database management can be opened by button on the start page: “Manage KEB documents” or via 
toolbar: 
 

 
 
The document manager window opens: 
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In the tab “Installed” the documents available on the computer packages are displayed. A green background 
means that the package is up to date. 
 

 
 

13.2 Use KEB Documents 

Two ways to access the documents are available: 
 
Global access to all existing documents: 
 
Database can be opened via start page “KEB Documents”  

Amount of data of selection 

Overview about available/ currently in-

stalled packages 

Choose packages to be installed 

Information on the contents of the 

package 
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Or via the toolbar:  
 

 
 
The editor “KEB-Documents” opens. 
 
The searching can be done for part-No., data type, area, language. 
 

 
 
When entering the part number, devices are proposed which are contained in the configurator database. 
Numbers of other KEB devices are also accepted. 

Editor 

Search mask 

Result of filtering 
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The document is opened by double-clicking on the document name. Via the context menu - right mouse but-
ton - on the document name different options are available. 
 

 
 
Device depending access to documents: 
 
In the Device Editor there is the tab “Documents”. The documents can be searched by device part number. A 
part number you enter here will be permanently assigned to the unit in the project. 
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PDF-Viewer: 
 
The used PDF Viewer can be set by menu “Tools” → “Options” → “KEB documents”. The proposed PDF X-
Change Viewer offers some advantages compared to other commonly used PDF viewers. 
 

 
 

13.3 KEB PDF Viewer 

The KEB PDF Viewer is a simple program adapted to the KEB document database. It will be installed during 
the installation of CV6. 
Other viewers can also be used but have partially limited functionality. 

Free choose able name  

Available documents open by 

double click 

Add / delete device from 

list 

Part No. of devices 

Refresh 
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(For example: With Adobe Reader, the parameter search cannot be performed on the parameter if the docu-
ment is already open.)

 
 
The toolbar can be customized by dragging and dropping the fields along the dashed line. 
 

 
 
The used PDF viewer can be chosen under Toolbar "Tools" → "Options" → "KEB documents". 
 

 
 

  

Tool bar 

Contents 

Result of searching 

Search window 

View of the document 
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14 KEB Safety Module Editor  

The KEB Safety Module Editor is used for parameterization and analysis of data in the KEB Safety Modules 
in COMBIVERT F6-A, H6 and S6-A. 
 
For the Safety Module Editor special system requirements apply, => chapter 2.3. 
 

14.1 Open Editor 

The Safety Module Editor is connected to the device and shown below the drive controller in the Navigator. It 
can be opened by double click with mouse on the name. 
 

 
 
If not, please open KEB Safety Module Editor by  
Right-mouse-key → choose “Add Object” → “KEB Safety Module” → “Add”: 
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Or: in tool bar click on icon    → “KEB Safety Module” → “Add” 
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Please find the description of parameters and editor in the manual of the safety module. 
 
The number of read lines of the log file can be limited. 
 

 
 

14.2 Print Configuration 

The configuration of the safety module can be printed: 
 
Open safety module editor → select tab “Safe parameterization” → menu: “File” → “Print”. 
By PDF-creator program an image file can be created. 
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If the print shall include an individual file name, the configuration may be saved. The name can be assigned. 
After re-import, the file name appears in the line "Import file". 
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15 Frequently Asked Questions 

15.1 FAQ General 

 
a) Is it possible to use COMBIVIS 5 and COMBIVIS 6 in parallel? 

Both programs can be installed and opened at the same time. But each COM- and USB-interface 
can be used only by one of them. (e.g., CV5 by COM1/serial and CV6 by USB-COM6 will work) 

 
b) Is it possible to use COMBIVIS 6 twice at the same time? 

CV6 can be open several times at the same time. But each COM- and USB-interface can be used 
only by one of them.  

 
c) Is it possible to use parameter lists (.dw5), work lists (.wr5) and scope files (.sc5) of 

COMBIVIS 5 at COMBIVIS 6? 
With COMBIVIS 6 .dw5- and .wr5-files can be opened and saved. Sc5-files cannot be handled. 

 
d) Is it possible to parameterize older KEB drive controllers (e.g., F4) with CV6? 

No, it is not intended. 
 

e) After inserting a parameter list into the project, there is shown: “channel closed” in the online 
values. 
The device reference in the parameter list is not the same as in the actual device. → Adjust the 
device reference in the list. 

 
f) Is it possible to open several projects with CV6 at the same time? 

CV6 can handle only one project at the same time. But CV6 can be opened several times with 
different projects (also in different languages). 

 
g) Why will be found the same device several times by using the USB-Serial-Converter Part No. 

0058060-0020 / -0040? 
Because of the not specified node addresses at HSP5 the F5/HSP5 or B6 drive controller will be 
found at each scanned node address. (HSP5 is a face to face communication with only 2 members) 
→ Search only at one node address or, at manually searching, mark and open only one device (=>: 
2.6.2 KEB USB Serial Converter). 

 
h) By using USB-Serial-Converter at a HSP5-interface of F5/B6, the device will be not or only by 

searching several times found. 
In default of CV6 the searching procedure starts with 9600 baud and counts upwardly afterwards. 
This needs a little time, so that the device may not be detected. → use CV6 at searching on HSP5 
with fixed 38400 baud. 
Note: on serial interface DIN66019 other, smaller baud rates may be used (F5, default= 9600 baud). 

 
i) At handling of a parameter value, the property editor window is not shown. 

Or: Parameter value cannot be changed. 
Please try to open the property editor window in the toolbar menu “view”. 
Afterwards search at the screen frame. May be the property editor window is collapsed. 
If found, click into the property editor window, and open it. Clicking on the pin symbol fixes the 
window open. 
A complete restoring of all windows can be done by toolbar: “Window” → “Reset window layout”. 
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j) The copy function Fr01 at COMBIVERT F5/B6/G6 seems not to work. 
With the parameter set copy function Fr01 at COMBIVERT F5 / B6 / G6 finished sets can be copied 
to other sets and then does not have to enter all the parameters again. The copy function runs in the 
drive controller and is triggered by COMBIVIS by entering the parameter Fr01 only. 

 
Because of the parameter "copy function" is set programmable, the set addressing mode plays an 
essential role in the process. 
When copying the "collapsed" parameter the direct addressed set is the target (usually are then 
target and source set equal to 0): 

 

 
 

Solution: Please adjust in column “set” the number of the set which is the target of the copying and 
adjust in the column “Offline/Online value” the number of the set which is to copy. 

 
k) The editor window is empty / shows no parameter. 
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For every firmware of each KEB device a description of the parameters is needed in COMBIVIS. 
Parameter description for this firmware of the device is missing (=> 16 Update Function). 

 
l) In editor is shown “service not available” at every parameter value. 

When operating with bus systems in "synchronous operation" only indirect addressing may be used 
(=> 4.7.1 Set Addressing). 

 

15.2 FAQ Scope 

a) Is it possible to record more than 16 channels? 
Each scope can handle max. 16 channels, but Scope can be opened several times in a project, each 
with 16 different channels.  

 
b) If a channel which is in the fast Scope mode will be disabled, does the 5th channel move up 

into the fast Scope mode or does the previous reservation persist? 
Yes. The channel “moves up”. 

 
c) Is it possible to save a CV6-scope in CV5 (.sc5) format? 

No, because of different and upgraded structures it is not possible. 
 

d) Is it possible to merge channels from different scope recordings? 
This is planned for a later COMBIVIS 6 version. Currently it is already possible, but only indirectly via 
export in an Excel-compatible format for example “CSV”. In Excel it is possible to merge curves as 
tables based on time-axis and compare them directly via diagram function. 

 
e) The externally stored Scope file ending .sc6 cannot be opened. 

With COMBIVIS 6 versions up to 6.2.2.0 only an XML file can be imported! The file extension .sc6 
was introduced with version 6.2.3.0, to better distinguish Scope files of other XML files. The data 
format .sc6 continues to be an XML format. The .sc6 file extension can be changed to XML and thus 
imported into earlier versions COMBIVIS 6. 

 

15.3 Known Malfunctions in Version 6.7. 

Regarding known malfunction of KEB COMBICONTROL please see the belonging manuals. 
 

a) The horizontal cursors in Scope locks only on the values of the first channel. The values of the other 
channels cannot be matched. 
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Workaround: By “Scope” → “Settings” → “Extended”: disable the hook at “Cursors snap to values”. 
Within the cursors can be placed freely by mouse. 
 

 
 

b) At German Windows operating system and setting in English, the COMBIVERT G6 / F6 ASCL / SCL 
wizard has problems if the comma is used to separate the decimal place. 
 

 
 
Workaround: If a value with decimal place is entered, the usual dot in English must be used. A 
comma will be ignored! In the display, however, "by default" can be a comma and then also applies. 
(The parameter editor can use either a dot or a comma, both are valid). 
 

c) At starting of COMBVIS or COMBVIS studio an error message pops up: 
The file C:\Programdata\COMBIVIS6\......COMBIVIS6ProjectDefaults.opt could not be loaded. 
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Please see => 11.5 Error Messages 
 

d) COMBIVIS Window does not open. 
COMBIVIS minimized Icon is in the task bar, by click on this, the window does not open. Sometimes 
you can see the window flying out of the screen. This can happen when COMBIVIS was placed on 
the remote screen, and this was disconnected. COMBIVIS opens on the no longer existing screen.  
It is not a problem of COMBIVIS only. But we have seen this also on other programs (e.g., Microsoft 
Excel).The effect comes from the windows display handler. 
 
You can solve the effect by: 
Push “shift key” and hold and push “right mouse key” on the minimized Icon of COMBIVIS in the task 
bar at the bottom of the screen. A window opens and select “maximise”. Then you see the 
COMBIVIS window. Then put the upper frame line by the mouse pointer and lower the size of the 
window. By this procedure windows orders the COMBIVIS window to the main screen. 

 

16 Update Function 

16.1 Manually Checking for Updates 

With function “Check for updates” on the start page or in menu “Help” an automatically connection to the 
KEB-homepage is done if a connection to the internet is available. The parameter description file “paras.xml” 
is checked for a newer date and downloaded/integrated if desired. 
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16.2 Automatically Checking for Updates 

As background function COMBIVIS 6 can search automatically for an update if the internet connection is ac-
tive (=> 6.4 Online Update). 
 

16.3 Manually Update for Parameter Description 

If update by Internet will not work, the parameter description can be got from KEB-Homepage and copied by 
external storage (e.g., USB Stick) into COMBIVIS. 
Search on www.KEB.de for the file “paras.xml” → store on the PC or stick → and integrate by: Menu “Tools” 
→ “Import KEB parameter-description file”. 
 

 
 
After importing a reload must be done or the COMBIVIS must be restarted. 
  

http://www.keb.de/
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17 Drive Storage 

17.1 Drive storage Wizard 

The device storage wizard enables the transfer of recipe lists in the device memory of COMBIVERT F6 and 
S6 as of firmware V2.3. 
 
The connection can be made via 

• cable part. No. 0058025-001D (=> 2.7.1 Serial cable) 

• KEB-USB serial converter Part. No. 0058060-0040 from version V2.4 and the designation "FTP 
ready" on the Type plate (=> 2.7.2 KEB USB converter) 

• UDP Port 8002 on COMBIVERT F6/S6 Pro on the internal Ethernet interface 
 
Note:  

• Communication over the F6 Ethernet operator or the F6 USB operator opens only access to 
operator-internal store, not to the drive! 

• Files in compressed form (zip files) cannot be loaded into the drive storage. 

• Accessing the drive storage and loading recipes into the unit only works when the modulation is 
switched off (status voltage enabled, switched on, ready to switch on). 

 
The function of the recipe management is described in the programming manual of the COMBIVERT (key-
word: “recipe management”. It can be found in the document data base. 
 
With the drive storage wizard also other file types can be transferred (like firmware, description files etc.). 
 
The drive storage is in the device editor: 
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Recipes have the file ending „.dw5“. 
 

17.1.1 Access Level / Password 

For transfer or deleting a specific access level is required, depending on the file function: 
 

• No access: Level 0 = read-only 

• User access: Level 3 or 4 = Application, Password: 440 

• Service access: Level 5, 6 or 7 = Supervisor, Password *** 

• Operating system: Level 10 
 

Open connection to 

drive storage 

Storage area for file transfer 

Contactor blue = Commu-

nication with drive storage 

green = with device, 

red = offline 

Transfer files Show file system Files in the drive storage Files on the PC 
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The password must be adjusted by the key symbol. 
 

 
 
The key button in the tool bar or in the parameter editor at the bottom cannot be used for that! 
 
The current access is displayed here: 
 

 
 
After Power-On-Reset the access level is 0: read-only. 
 

17.1.2 Connect Drive Storage 

Klick on the button “Connect”. 
If needed enter the password. 
The connection to the parameter interface (green contactor in the navigator) is interrupted and `redirected` to 
the internal storage (blue contactor). The parameters are not accessible while using the drive storage wizard. 
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17.1.3 Show Stored Recipes 

Tab Recipe management. 
 
The recipes can be transferred to the Navigator as a parameter list. 
 

 
 

17.1.4 Create a Recipe 

A parameter list can be loaded directly from the Navigator as a recipe into the COMBIVERT. 
 
Select the parameter list → right mouse key → “Download as a recipe”. 
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A Password is required. The user password is typically “440” (Level 3). 
 

 
 
The file names of the recipes must meet certain criteria (=> Programming Manual). 
The function and the name can be selected. 
 

 
 
With "OK" the list is transferred as a recipe to the device storage. 
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17.1.5 File System / Transfer File 

In the "File system" card, the file system of the PC is shown in the left half of the window and the COMBI-
VERT file system in the right half of the window. 
The drives C: and D: are available in COMBIVERT. Normally, C: stores the user-specific files (recipes) and 
D: the system-relevant files (firmware, etc.). 
 
The file names of the recipes must meet certain criteria (=> Programming Manual). 
 
Transfer a recipe from the PC file system to the COMBIVERT: Select files → by “>” transfer from one to 
the other file system or drag and drop the file from the PC file system onto the dashed area. 
 

 
 
Transferring a recipe from the COMBIVERT to the PC file system: Select files → Transfer by “<” from 
one file system to another. 
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17.1.6 Edit Recipe in the File System 

The recipe can be deleted from the file system (trashcan icon). 
The recipe name can be changed. 
 

 
 
The content of a recipe can be changed by transferring it as a parameter list to the Navigator and saving it 
again as a recipe after the change (=> 17.1.3 Recipe Management). 
 

17.1.7 Disconnect 

After the connection has been disconnected, the connection to the parameterization interface of the COMBI-
VERT opens again = green connector symbol in the Navigator. 
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17.2 KEB-FTP File Transport Program 

By KEB File Transfer Program Files can be transferred between PC and KEB devices 

• PC and KEB Portable-Operator (Part No. 0058060-1010 /-1110) with USB cable 

• PC and COMBICONTROL C5 / C6COMPACT I+II, H6CU, P6, T6MCU with LAN cable (not with KEB 
USB converter) 

• PC and operator of COMBIVERT F6 with USB- or LAN cable 

• PC and COMBIVERT S6 /F6 with cable Part No. 0058025-001D (=> 2.7.1 Serial cable) or KEB-
USB-Serial-converter Part No. 0058060-0040 from version V2.4 and signed as “FTP ready” on the 
type plate (=> 2.7.2 KEB USB converter) 

• UDP Port 8002 on COMBIVERT F6/S6 Pro on the internal Ethernet interface 
 
Note:  

• Communication over the F6 Ethernet operator or the F6 USB operator opens only access to 
operator-internal store, not to the drive! 

• Files in compressed form (zip files) cannot be loaded into the drive storage. 

• Accessing the drive storage and loading recipes into the unit only works when the modulation is 
switched off (status voltage enabled, switched on, ready to switch on). 

• Not useable for C6 IPC types! 
 
Open: 
Menu bar “Tools” → “KEBFTP” 
 

 
 
Note: 
KEB-FTP is a separate program running parallel to COMBIVIS 6. It is not possible for KEB-FTP and 
COMBIVIS 6 to serve the same COM-Port at the same time. So, the used COM Port in KEB-FTP must be 
inactive in COMBIVIS 6. 
 
Adjustments: 
IP-address or COM-Port and password if required (=> device manual) must be adjusted. Then click on But-
ton “Connect”. 
The password resets, depending on device, sometime after last serving. 
 
For COMBIVERT F6/S6 the baud rate must be at 115200. 
 
The file length is limited compared to Windows Explorer 
COMBICONTROL C5 = 8 digits + file extension 
COMBICONTROL C6 = 32 digits + file extension 
Portable Operator       = 32 digits + file extension 
Please consider the device manual 
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Transfer data from 

device to PC 

Data in the PC Data in the device 

Transfer data from PC to device Adjustments for communication 
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18 Configurator 

18.1 Properties 

The KEB Configurator is a tool for easy modelling of KEB drive systems. While assembling these models you 
are supported by an intuitive Graphical User Interface (GUI) and different component selection wizards. 
You can use the created systems for documentation purposes. Furthermore, you can generate COMBIVIS 
(or COMBIVIS studio) projects and part lists, e.g., for requesting a quotation. 
The Configurator also provides easy access to the technical data of KEB devices and their documentation. 
 
Please Note: In the Configurator, the standard portfolio of KEB is included. For special options, please con-
tact directly to the KEB sales. 
 

18.2 Start Configurator 

Open by Start page: 
 

 
 
Or by “New project” and “Configuration” 
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Or in an already existing project: Add by “Add object”: 
 

 
 
Or via the menu: 
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Or via tool bar: 
 

 
 

18.3 Work with Configurator 

The Configurators user interface consists of 3 main parts: 
 

 
 

1. Workspace 
Here all selected devices are shown, placed, and connected. 

2. Product selection window 
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The elements are shown that can be used in the Configurator. 
3. Properties window 

The properties of the elements selected in the workspace are shown. 
 

18.3.1 Workspace 

 
 

18.3.2 Connections 

Connection (Cables) can be inserted from the product selection or by drawing a new connection from an in-
terface with the mouse: 
 

Miniature view with zooming option 

Placed and connected elements 
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A fitting connection is automatically inserted. If multiple connections are possible, one must be selected from 
the dialog that will appear automatically in this case. 
 

18.3.3 Document Access 

Using the context menu, it is possible to access all documents associated with that element: 
 

Possible interfaces for a connection 

are highlighted 
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18.3.4 Product Selection Window 

 
 
Example of a product selection wizard: 
 

Part number filter 

Start configuration wizard 

Select elements via double click or 

drag & drop 
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If no wizard is available, the elements will be shown in a table. This view is also available from a wizard using 
the “Expert view”-tab. 
 

 
 

For each column, a filter can be 

set. 

“Expert view”-tab 
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18.3.5 Properties Window 

 
 

18.4 Generate COMBIVIS Project 

From a Configuration the contents of a COMBIVIS project can be generated. 
This is done via the menu:  
 

 
 
Or via tool bar: 
 

 
 
This menu command opens a preview dialog where additional adjustments can be made: 
 

Editable properties of the selected 

elements 

Technical data of the selected ele-

ments 
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In COMBIVIS studio 6 in addition to the parameter based devices also PLC devices with complete EtherCAT 
or CAN-Bus topologies can be generated: 
 

 
 
Depending on the size of the project to generate this might take a moment. 
 
After the generation, the relation between the elements in the configuration and the created objects persists, 
which enables additional functionalities: 
 
Open created objects: 
 



Configurator 

226   © 2022  KEB Automation KG 
     

 

 
 
Using the context menu all generated objects can be opened.  
 
Open in Configuration: 
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From the navigator the corresponding elements can be highlighted in the Configurator. 
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18.5 Part List / BOM 

The part list is available using the menu: 
 

 
 
Or via tool bar: 
 

 
 
The part list contains all elements from the Configuration. There are options to customize the view. Different 
export formats are available as well as a print option. 
 

Highlighted elements blink for some 

seconds 
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18.6 Extended Document Search 

Extended document search 
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In the “Documents”-tab of the editor for KEB devices all relevant documents for that device can be listed. 
This list contains for instance all documents for the device and the connected motor. 
  

Load data from configuration 
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19 Registration and License 

Registration: valid for COMBIVIS 6, free of charge, enables the access of the KEB document data bench. 
License: valid only for COMBVIS studio 6, fee required, disables the demo mode, includes the registration. 
 

19.1 Registration 

The free registration of COMBIVIS 6 allows access to the document database. Configurator, parameteriza-
tion, data backup and scope work in demo version without restriction. 
 
For registration, an Internet access must be available. Similarly, an account on the KEB homepage must be 
created. In the login-area the registration key can be generated. 
If you have a license for COMBIVIS studio 6 the registration is included. 
 
Procedure: 

• An internet connection is needed. 

• On the start page you find a link to the registration: 
 

 
 

• You will be guided to the KEB homepage: 
 

 
 

• Please log in your account or create a new: 
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• Then open “COMBIVIS registration”: 
 

 
 

• Create the key by “Show registration key”: 



Registration and License 

© 2022  KEB Automation KG   233 
     
 

 
 

• The registration key is a 40-digit letter-number combination: 
 

 
 

• Copy company name and registration key to the window in COMBIVIS: 
 

 
 

• After registration COMBIVIS 6 needs a new start. 
 
The registration is not related to the computer and can also be used on several computers. 
The key is stored as file "customer.nfo" on C: \ Program Files (x86) \ KEB \ COMBIVIS_6 \ KEB  
or from V6.7.x alternatively on C:\ProgramData\COMBIVIS 6. 
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19.2 Licensing 

The installed COMBIVIS studio 6 version is a demo version. This runs for a maximum of 1 hour and no boot 
projects can be created. After expiry, the demo version can always be restarted again. To obtain the full 
range of functions you need a licence. Please contact your KEB sales representative. The procedure for li-
censing COMBIVIS studio 6 is described in the Release Notes/ Chapter 7: Menu "Help" → "Show Release 
Notes". 
 

 
 
Additionally, there is a manual in the document data bench => 13.2 use documents: 
 

 
 
The COMBIVIS studio 6 License includes the registration => 19.1 Registration. 
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20 IPScan Tool 

The IPScan tool makes it easy to find accessible devices in your own subnetwork. 

20.1 General 

KEB IPScan uses the UDP protocol to transfer a block of data to allow detecting KEB devices with Ethernet 
interface. The scan request is sent from a device called “IPScanner” via broadcast to reach all devices in the 
local network subnet range. All devices with IPScan functionality (KEB Kontiki based firmware) respond to 
the IPScanner with their name, location, and IP parameters. Also, any active instance of IPScan.exe soft-
ware is found (e.g., IPScan running in C6-IPC).  
 

20.2 Supported Devices 

• Full support: embedded devices (C6-C,H6-CU, P6, T6) + F5 Ethernet operator, Port expander 

• Limited support: C6 X86 based (ECON, PERFORM, E22, P3X) 

• Not supported: arm based WEC7 devices (C6 SMART, C6 HMI LC) 
 

20.3 Ports 

The request port is 67 on the UDP protocol, the response port is 68. Sometimes the response port on the 
IPScanner is in use, so an alternative port can be used (devices with firmware after year 2014). 
 

20.4 Scanning 

By pressing the “Scan devices” button a call to the network is issued and the responding devices appear in 
the list below. 
 

20.5 Wink 

By pressing the “Wink this device” button the selected device from the list is asked to show a local response. 
This can be a blinking light or flashing header, depending on the specific hardware. 
 

20.6 Assign 

With the “Assign IP address” button, the selected device parameters and location may be changed. This 
highly depends on the selected device type and needs a specific password for that. It is primary used by ser-
vice personnel. 
 

20.7 More Device Info 

The ‘Info’ button shows additional information about the selected device (if available). 
 

20.8 Use IP Scan 

The program works independent from COMBIVIS, but is opened in COMBIVIS. 
 
Menu bar “Tools” → “IPScan” 
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Reserved for KEB 

Service 
Start network scan Device blinks (see device manual) 
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21 Energy Efficiency Tool 

Every manufacturer of drive technology is obliged to submit an energy efficiency declaration for their devices. 
With this plug-in the energy efficiency of different types of COMBIVERT can be classified and documented. 
The plug-in calculated absolute and relative power losses in eight different load levels in accordance with EN 
61800-9-2. Users can also define up to 8 additional custom load points to determine the exact efficiency of 
the COMBIVERT. 
For all KEB devices, even those which are not listed in the tool, the declaration can be obtained from the 
document database or from the KEB homepage www.keb.de as PDF (search for part number -> data 
sheets). 
 

21.1 Function 

This plug-in creates a PDF document for a specified KEB COMBIVERT. The KEB Configurator is the data 
base. Therefor only devices are offered which are parts of configurator. 
The operating points refer to the torque-generating current and the rated frequency of the motor. 
 
The losses are related to the rated apparent power of the COMBIVERT. 
The energy efficiency tool can be opened directly from the configurator or as an editor in the Navigator. 
 
Configurator: 
From the configuration project, select a specific COMBIVERT and right-click on it to go to the context menu. 
Then click on "Generate Energy Efficiency Declaration". 
 

 
 
Navigator: 
In the Navigator, right-click the project node and navigate to the Add Object item. Click on the "Energy Effi-
ciency Declaration" button to open the editor. 
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Choose a name for the editor: 
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Coming from the Navigator, the COMBIVERT must be selected from the list. After opening the window, the 
1st device is displayed in the list. Select the correct COMBIVERT based on the part number. 
 

 
 
In the default setting, the relative and absolute losses are displayed for the operating points defined in EN 
61800-9-2. 

Data points for 

losses calculation 

User defined operating 

points 

Generate a document 

Losses at the oper-

ating points norma-

tive and user defined 

Activate the loss-

time-profile 

Choose device 
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In addition, the user can define up to 8 own load points. The loss values are interpolated from the normative 
values. The points can be entered by a mouse double-click in the left-hand graph or manually in the table 
"Custom load points". 
 

 
 

21.2 Loss-time profile 

This can be used to create a curve that shows the losses over an operating cycle. 
 
The profile is activated by setting the check mark in the field “Loss time options”. 
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The cycle time can be entered absolutely in seconds or relative. 
 
The profile is generated exclusively from the table of "Custom load points". 
To integrate normative load points, these can be pulled down from the above table "Normative load points" 
by mouse. The time values must be entered manually. 
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21.3 Create Declaration / Data Sheet 

After defining the work points and optionally the loss-time profile, the user can create a PDF report. The re-
port contains all the important device data, the normative and custom defined loss values, and the loss-time 
profile (if selected). 
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22 Parameter Cockpit 

The function Parameter Cockpit is a tool to display parameter values in separate window and bigger size. 
 
Parameter Cockpit can be opened at project or node/device. 
When the cockpit is opened on the project, parameters of several units can be inserted. If it is opened on a 
specific unit, only from that unit. 
Open by menu bar icon “add object”: 
 

 
 
Or in the navigator with right mouse click: 
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Set a name: 
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The Parameter Cockpit includes 8 view boxes. 
 
Parameters can be set by Drag&Drop from the device parameter editor or from a parameter list to one of the 
view boxes. 
 

 
 
The Parameter Cockpit is placed at the bottom of the editor window. It can be placed also on other sides (=> 
7 Window Layout) 
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Parameter Cockpit can be added several times. 
Parameters from several units can be placed together in a Parameter Cockpit if it is attached to the project 
and not to a specific unit. 
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23 Plug-ins – Additional Modules 

Additional modules for COMBIVIS 6 and / or COMBIVIS studio 6 can be published during the term of the re-
lease. These are either integrated via the update function or as a separate installation. The description for 
the additional modules is published separately in the KEB document database (=> 13 document database). 
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